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ABSTRACT 

 
 STRUCTURAL RELIABILITY ANALYSIS FOR VESSEL 

IMPACT ON BRIDGES 

 

 

 

 

Kenneth Brian Berlin, M.S.E. 

The University of Texas at Austin, 2005 

SUPERVISOR:  Lance Manuel 

 

The collapse of the Queen Isabella Causeway in 2001 due to a vessel 

collision was an alarming message to the state of Texas that vessel impact on 

bridges is a serious issue and may need to be considered for all bridges that span 

waterways.  The Texas Department of Transportation funded this research project 

that was aimed at examining in detail the AASHTO LRFD code provisions for 

vessel impact on bridges.  The goals of the present study are to develop a stand-

alone computer program that utilizes information on waterways, vessels, traffic, 

and bridges in a probabilistic analysis that estimates the annual frequency of 

collapse. 
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According to today’s code provisions for vessel impact on bridges, a 

bridge is required to have a specific minimum return period associated with 

collapse depending on its importance classification.  A user-friendly stand-alone 

computer program, VIOB, is developed to make it possible to carry out the 

required calculations that lead to estimates of the return period. 

Given information related to the bridge and pier geometry, the waterway, 

and the vessel traffic at a given mile marker of a waterway where the bridge is 

located, VIOB produces an in-depth report detailing all the calculations.  This 

report provides information on the analysis performed and also includes 

summaries that allow the user to determine sources of vulnerability for the bridge.  

Such information is useful in improving a bridge design when, for example, code 

specifications are not met.  VIOB integrates databases with analysis capabilities 

and makes it possible to carry out calculations related to an important problem – 

the safety of bridges against vessel impact. 
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CHAPTER 1 
Introduction 

 

1.1 BACKGROUND 

The Queen Isabella Causeway allows vehicles to drive from Port Isabella, 

Texas along Park Road 100 over the Gulf Intercoastal Waterway to South Padre 

Island.  On September 15, 2001 a four-barge tow collided with the Queen Isabella 

Causeway triggering a collapse of Bent 32.  The collapse can be seen in Figure 

1-1.  The catastrophe left a gaping 160-foot fissure in the bridge and caused the 

deaths of eight people as their cars plunged 87 feet into the water below 

(Schwartz, 2001; Texas Civil Engineer, 2004). 

 

 

Figure 1-1: The Queen Isabella Causeway Collapses in September 2001 

(Source: Calzada). 
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At the time of the accident, the Queen Isabella Causeway was the only 

means of transportation for visitors to and from South Padre Island.  The 

destruction of this bridge, shown in Figure 1-2, effectively stranded thousands of 

people on the island until ferries could be brought in to transport them to the 

mainland.  Given the importance of this bridge to the surrounding communities, 

the tragedy due to the loss of life was exacerbated by the economic crippling of an 

entire region. 

 

 

Figure 1-2: The Collapsed Portion of the Queen Isabella Causeway (Source: 

South Texas Business Directory). 

When the captain and crew of the barge tow were questioned about the 

incident, it was determined that neither drugs nor alcohol were involved in the 

accident; however, the barge tow was several hundred feet off course when it 

slammed into the Queen Isabella Causeway.  One possible explanation that has 

been suggested is that there might have been some particularly high currents in 
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the curved channel leading up to the bridge at the time of the accident that the 

captain of the barge tow was unaware of (Schwartz, 2001). 

Vessel collisions are not unique to Texas.  Months after the Queen Isabella 

Causeway disaster, Oklahoma experienced a similar bridge collapse.  On May 27, 

2002 a barge captain blacked out as his barge tow was approaching Interstate 40 

where it crosses over the Arkansas River in Webbers Falls, Oklahoma.  The 

collision caused 600 feet of the bridge to collapse (See Figure 1-3), killing 

fourteen people when their vehicles drove off the collapsed bridge (National 

Transportation Safety Board, 2004). 

 

Figure 1-3: Bridge in Webbers Falls Oklahoma Collapses Due to Vessel 

Collision (Source: The Anniston Star). 

While the Webbers Falls and Queen Isabella Causeway vessel collisions 

were fairly recent, the history of vessel collisions with bridges in the United States 

is quite extensive.  Possibly the largest bridge collapse due to vessel impact in the 

U.S. occurred in 1980 in Tampa Bay where a 1400-foot span of the Sunshine 

Skyway Bridge was destroyed when a ship collided into one of the main piers 
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killing 35 people.  In 1993, a barge tow collided with the Judge William Seeber 

Bridge in New Orleans killing three people. 

Vessel collisions with bridge piers have occurred in the past and they will 

likely continue to occur in the future.  According to Frandsen (1983), the annual 

rate of catastrophic collisions during the period 1960-1970 was 0.5 bridges per 

year.  However, that number tripled to 1.5 bridges per year during the period 

1971-1982.  This increased number of bridge failures over time resulted due to an 

increase in the number of bridges over navigable waterways as well as an 

increased volume of vessels using those waterways (AASHTO, 1991).  

The recent Queen Isabella Causeway bridge collapse and other vessel 

collisions on bridges motivated the present research study supported by the Texas 

Department of Transportation (TxDOT) which aims to evaluate bridges spanning 

waterways in the state of Texas for safety against vessel collisions. 

Having experienced the horrific disaster that occurred due to the Queen 

Isabella Causeway collapse, TxDOT decided to analyze each of the state’s bridges 

that span waterways to determine if rehabilitation might be needed to prevent a 

similar accident.  Using available software that can assess the likelihood of a 

bridge collapse due to vessel collisions, TxDOT performed the appropriate 

AASHTO calculations which also helped identify bridges that require attention.  

A shortcoming of the analyses that were carried out was that the data especially 

on vessel traffic and waterways were not generally available. 

This thesis is part of a research study that is comprised of three separate 

tasks: structural reliability analysis, bridge ultimate strength models, and finite 

element modeling to assess impact forces.  In addition, a comprehensive database 

development effort is an integral part of this research project.  The parts of the 

project will be integrated together to help identify Texas bridges that might be at 

risk of failure due to vessel collision. 
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1.1.1 Bridge ultimate strength models 

In order to accurately assess the vulnerability of a bridge against vessel 

impacts, it is necessary to determine the strength of exposed bridge piers.  By 

taking into account such factors as the superstructure stiffness, soil stiffness, 

vessel force, and pier geometry, models are being developed (Henderson, 2005) to 

determine the ultimate lateral strength of a bridge pier.  Different structural 

analysis computer programs such as ANSYS and SAP2000 are being used to 

perform nonlinear static pushover analyses to determine the ultimate strength of a 

pier. 

1.1.2 Finite element modeling to assess impact forces 

Using LS-DYNA, a finite element analysis program, models are being 

developed (Cryer, 2005) to determine the characteristics of the force transferred 

from a vessel to a pier during a collision.  Important variables include the vessel 

speed, current velocity, pier stiffness, vessel hull stiffness, and angle of impact.  

Taking into consideration these variables, a model is being developed to provide 

descriptions of the impact force for the reliability study. 

1.1.3 Data Collection 

Because data on waterway characteristics and vessel traffic on Texas 

waterways are not easily available, a database is being developed as part of this 

research study.  Using information from sources such as the Army Corps of 

Engineers and commercial towing companies, vessel traffic and channel data are 

being assembled at various mile markers on Texas waterways.  The data include 

information regarding channel profile, channel currents, vessel traffic, and vessel 

geometry.  These data are essential in assessing the return period for bridge 

collapse due to vessel impact. 



 6

1.1.4 Structural Reliability Analysis 

Using models developed for vessel impact forces and for ultimate strength 

of piers along with data on vessel traffic and on the channels, a probabilistic 

framework is developed to estimate the return period associated with bridge 

collapse due to vessel impacts.  Calculations also involve the use of databases 

developed along with formulations for estimating the probability of aberrant 

vessels, consideration of the channel geometry, and the vessel traffic.  Estimates 

of the return period help transportation agencies identify bridges that might be 

vulnerable to collisions and are useful in prioritizing resources for retrofitting of 

at-risk bridges that span waterways. 

1.2 SCOPE OF THESIS 

There are many different factors that influence vessel impact analysis for 

bridges including the bridge geometry and structural properties, channel 

characteristics, and vessel traffic data.  This thesis focuses on the structural 

reliability analysis calculations which are integrated into a stand-alone analysis 

program that makes use of databases and models to evaluate bridge against vessel 

impact.  The entire numerical framework for estimating return periods for bridge 

collapse due to vessel impact involving various models as well as Texas-specific 

databases has been conveniently incorporated in a user-friendly software program, 

VIOB, which is developed as part of this study.  This software program allows the 

user to complete detailed calculations of the type needed when following the 

AASHTO LRFD specifications (AASHTO, 2004).  The ease of use of this 

software is a major improvement over previously existing computational tools for 

such analyses. 
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1.3 ORGANIZATION OF THESIS 

This thesis is organized in the same way that the research itself 

progressed.  First, a literature review describing past research efforts is presented 

in Chapter 2.  This is followed in Chapter 3 by a detailed description of the 

AASHTO LRFD methodology currently in use when evaluating bridges for vessel 

impact loads.  Next, some changes to the AASHTO methods that we propose for 

the reliability analysis based on our understanding of vessel impact forces and 

bridge pier ultimate strength models are described in Chapter 4.  A set of example 

calculations are included in Chapter 5.  Building on the example calculations, 

Chapter 6 compares results for different bridges.  A presentation of VIOB, the 

computer software developed for this research is outlined in Chapter 7.  Finally, 

some general conclusions arising from this research are included in Chapter 8. 
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CHAPTER 2 
Literature Review 

 

2.1 PREVIOUS VESSEL IMPACT STUDIES 

Consideration for the design of bridges against vessel impact is important 

in many countries around the world.  Land-locked countries must be concerned 

with vessel traffic in rivers, channels and lakes, while countries by the ocean must 

account for vessel traffic entering and leaving its ports.  Vessels have been known 

to collide with other vessels, with bridge piers, and with other obstacles.  

Countries like the United States, Japan, and Germany have, over the years, carried 

out numerous research studies dealing with vessel impact on bridges and other 

obstacles. 

In Japan, Fuji and Shiobara (1978) reported on tests representing ship-to-

ship collisions to determine the annual economic losses occurring in Tokyo Bay.  

Their studies related the probability of collision between two vessels at sea and 

the associated rate of damage caused.  Due to a lack of vessel-to-pier collision 

data at the time of the writing of the 1991 AASHTO Guide Specification 

(AASHTO, 1991), studies of ship-ship collisions including the one by Fuji and 

Shiobara (1978) were modified to apply to vessel-pier collisions.   

The commentary in both the AASHTO LRFD Specifications (AASHTO, 

2004) and the earlier 1991 Guide Specification (AASHTO, 1991) refers to two 

sets of experiments conducted in Europe that were used as a basis for establishing 

critical relationships provided in the Specifications for computing vessel damage 

and impact forces.  For ships, these experiments were largely based on the work 

of Woisin, conducted in Germany in the late 1960s to the mid 1970s (Woisin, 
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1970, 1971, 1976).  Similarly, for barges, the expressions in the two AASHTO 

documents provided for vessel damage and collision force were based on the 

experimental work of Meir-Dornberg, published in German in 1983 (Meir-

Dornberg, 1983). 

Inland waterways in Germany have bridges that are very old and were not 

originally designed for vessel impact.  A recent study (Proske et al., 2003) 

discusses an approach for strengthening of such old bridges.  Probabilistic 

analysis techniques are used to correlate bridge damage to the number of ship 

impacts for different bridge structures. 

As far as experience with vessel impact studies in the United States is 

concerned, all states have bridges crossing waterways and hence, vessel collision 

is a problem in every state, not simply coastal states.  While national codes have 

been established to design against vessel collisions, research has been mostly 

performed in states which are at greatest risk.  Florida and Louisiana have led 

vessel collision research efforts in the U.S. but other states such as New Jersey 

and Kentucky have also influenced code development.  Texas, too, has 

undertaken its own research into vessel collision design. 

The state of Louisiana and the Federal Highway Administration 

introduced one of the first comprehensive code criteria for vessel impact 

(Modjeski and Masters Consulting Engineers, 1984).  These criteria describe in 

detail how to perform a vessel collision probabilistic analysis based on bridge, 

vessel, and channel data.  The model uses a dynamic analysis to determine vessel 

forces and also provides a simplified approach for design.  This model was one of 

the primary sources that led to the development of the 1991 AASHTO Guide 

Specifications (AASHTO, 1991). 

In the state of Florida, a significant amount of research has been done on 

the topic of vessel impact on bridges.  The University of Florida and the Florida 
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Department of Transportation have recently performed extensive tests relating to 

vessel impact on bridges (Consolazio et al., 2005).  In the area of probabilistic 

analysis for the return period of bridge collapse due to vessel impact, a Mathcad 

spreadsheet that could be linked to a vessel traffic database was developed to 

enable estimation of the annual frequency of collapse of susceptible bridges in the 

state of Florida (Florida Department of Transportation, 2000). 

The state of New Jersey has also dealt with vessel collision situations in 

practice.  For example, when Parsons Brinckerhoff was involved in the design of 

the Ocean City – Longport Bridge in the state, vessel collision forces controlled 

the design of several piers.  It was found to be most economical to use longer 

spans in the center portion of the bridge and the use of a fender system had a 

significant reduction in the annual frequency of collapse of the bridge (Rue et al., 

2002).  

In the state of Kentucky, the use of various types of data with Method II as 

given in the AASHTO Guide Specification is demonstrated by Whitney et al. 

(1996) for a cable-stayed bridge in the state. 

2.2 CHANGES IN THE DESIGN CODE 

While research into vessel impact design had been performed for many 

years around the world, vessel impact design did not seriously begin in the United 

States until 1980 when the Sunshine Skyway Bridge, in Tampa Bay, Florida, 

collapsed due to a ship collision (see Figure 2-1).  This catastrophic event forced 

researchers and officials to take a closer look at the frequency of vessel collisions 

and methods to prevent further accidents from occurring. 

 



 11

 

Figure 2-1: 1980 Sunshine Skyway Bridge Collapse (Source: Time Magazine). 

2.2.1 The 1991 AASHTO Guide Specification and Commentary for Vessel 

Collision Design of Highway Bridges 

The first attempts by AASHTO to formally address the design of bridges 

for vessel collision forces were made in 1991.  Following the Sunshine Skyway 

Bridge disaster, research into vessel collision was thought to be necessary.  

AASHTO examined the results from several research projects in other countries 

(see, for example, Fuji and Shiobara, 1978; Woisin, 1970, 1971, 1976; and Meir-

Dornberg, 1983) and in the United States (e.g., by Modjeski and Masters, 1984) 

and developed their first guide specifications (AASHTO, 1991).  These 

specifications, while not required for bridge design, include a large commentary 

component and propose guidelines for determining vessel impact loads and a 

procedure for designing a protective bridge barrier.  The guide specifications also 

attempt to create a preliminary vessel database that encompasses the most 

common types of vessels in use on waterways in the U.S.  
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2.2.2 The 2004 AASHTO LRFD Bridge Design Specifications 

Starting in 2004, vessel collision was formally incorporated into the 

primary AASHTO LRFD design code for bridges (AASHTO, 2004).  The 

guidelines here were adapted from the 1991 AASHTO Guide Specification with 

minor modifications made to streamline the design process and keep it consistent 

with the rest of the LRFD code.  Also, only Method II from the 1991 Guide 

Specification was retained in the 2004 AASHTO LRFD code.  This method is the 

optimal method of vessel collision design in terms of complexity and is similar in 

principle with the overall LRFD probabilistic design philosophy.  These 

AASHTO 2004 LRFD guide lines for vessel collision are discussed in further 

detail in Chapter 3.  
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CHAPTER 3 
The AASHTO Specifications for Vessel Impact on 

Bridges 
 

3.1 IMPLEMENTATION OF AASHTO GUIDE SPECIFICATION 

Developed from the AASHTO Guide Specifications and Commentary for 

Vessel Collision Design of Highway Bridges (AASHTO, 1991), the AASHTO 

LRFD code Section 3.14 outlines a procedure for estimating a bridge’s likelihood 

of collapse given that a vessel collides with it. 

The vessel collision requirements are aimed at preventing a vessel from 

impacting a bridge over a navigable waterway and causing excessive damage.  A 

probabilistic model based on a worst-case-scenario, where a fully loaded fast-

moving vessel collides with a pier while moving unimpeded, is used to determine 

whether a bridge is adequately designed.  In determining the feasibility of a given 

bridge it is necessary to consider the waterway geometry, the types of vessels 

using the waterway, the speed and load state of the waterway vessels, and the 

response of the structure in the event of a vessel collision. If a structure is unable 

to resist the vessel collision forces, it needs be protected by a fender system.   

The acceptable probability for any given bridge depends on the 

importance that the bridge serves to the community.  Bridges may be categorized 

as either “critical” or “regular” according to AASHTO LRFD code Section 

3.14.3.  If a bridge is classified as critical, it must remain operational after a vessel 

collision.  Once a bridge’s classification has been established, it is determined to 

have met the criteria according to its completed annual frequency of collapse. 
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3.1.1 Annual Frequency of Collapse 

The AAHSTO LRFD code uses annual frequency of collapse to determine 

whether a bridge design is satisfactory.  An alternative way of representing a 

bridge’s vulnerability is with the inverse of annual frequency of collapse, or 

return period.  A bridge’s return period is the number of years on average that a 

bridge may be expected to stand before a vessel collides with it and causes it to 

collapse.  The annual frequency of collapse resulting from collision of a single 

pier by a vessel is calculated as follows: 

 

 ))()()(( ijijijiij PCPGPANAF =  (3.1) 

 

where: 

AFij  = Annual frequency of collapse of pier j caused by vessel type i, 

Ni  = Annual number of vessel type i (a vessel must pass all piers), 

PAij  =  Probability of aberrancy of vessel type i with respect to pier j, 

PGij  =  Geometric probability associated with vessel type i and pier j, 

PCij  =  Probability of collapse of pier j due to vessel type i.  

 
Equation 3.1 suggests that the annual frequency of collapse is based on a 

number of different probabilities.  In sequence we need to know the probability 

that a vessel becomes aberrant; then, the probability that a vessel will strike the 

bridge given that it becomes aberrant; and finally the probability that the bridge 

will collapse given that a vessel is aberrant and strikes the bridge.   

The overall annual frequency of collapse of a bridge, AFTotal, is the sum of 

the annual frequencies that result from collisions of the various vessel types with 

the various bridge piers that one deemed vulnerable due to their location relative 

to the channel.  Thus, we have: 
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where: 

AFTotal  = Annual frequency of collapse of the bridge, 

NV  = Number of vessel types (i.e., including the same loading 

condition, size, etc.) that pass the bridge, 

NP = Number of bridge piers within three times the overall length 

(LOA) of the vessel from the navigable channel centerline. 

 

The sequence of computations is such that the annual frequency of 

collapse is determined for each pier and the sum of these frequencies for all piers 

provides the overall annual frequency of collapse of the bridge. For a bridge 

classified as “critical,” the annual frequency of collapse must be not greater than 

0.0001, or its return period must be not shorter than 10,000 years.  The required 

annual frequency of collapse for a bridge designated as “regular” must be no 

larger than 0.001 corresponding to a return period of 1,000 years.  In terms of 

these acceptable levels, we have: 

 
 AcpTotal AFAF <  (3.3) 

 
where: 

AFTotal  = Annual frequency of collapse of the bridge, 

AFAcp  = Acceptable annual frequency of collapse of the bridge. 

3.1.2 Probability of Aberrancy (PA) 

The probability of aberrancy is the likelihood that a vessel deviates off 

course due to pilot error, poor weather conditions, or mechanical failure.  One of 
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the three main components to determining the annual frequency of bridge 

collapse, the probability of aberrancy can be calculated by two different methods.  

The first method involves performing a statistical analysis of historical data from 

a given channel.  While this method is the most accurate, it can be time-

consuming and difficult.  The simplified approach detailed in AASHTO LRFD 

3.14.5.2.3 is an approximation method and can be written: 

 
 ))()()()(( DXCCB RRRRBRPA =  (3.4) 

 

where: 

PA  =  Probability of aberrancy, 

BR  =  Aberrancy base rate, 

RB  =  Correction factor for bridge location, 

RC  =  Correction factor for current acting parallel to vessel transit path, 

RXC =  Correction factor for cross-current acting perpendicular to vessel 

transit path, 

RD =  Correction factor for vessel traffic density. 

 

3.1.2.1 Aberrancy Base Rate 

From Equation 3.4, is can be seen that probability of aberrancy is 

calculated by starting with a base rate and then modifying it by four different 

factors.  The four correction factors adjust for bridge location, parallel current, 

perpendicular current, and traffic density.  Each of the five variables that 

influence probability of aberrancy is based on historical data for the waterway.   

The aberrancy base rate is the fraction of vessels that become aberrant.  

Ships are less likely to become aberrant than barges; therefore, the base rate for a 

ship is 0.00006 as opposed to 0.00012 for barges.  
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3.1.2.2 Correction for Bridge Location 

A correction factor for bridge location is necessary to adjust for the 

different types of channel geometry in the vicinity of the bridge.  Different turn 

regions exist in any channel and the sharper the turn angle the more difficult it 

becomes for the vessel operator to keep the vessel on course.  The AASHTO 

LRFD code distinguishes channel regions into three types: straight, transition, and 

turn/bend.   

 

 

Figure 3-1: Channel turn region (from AASHTO LRFD Figure 3.14.5.2.3-1a) 

 

Figure 3-2: Channel bend region (from AASHTO LRFD Figure 3.14.5.2.3-1b) 
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A straight region is the simplest; here, a vessel has a clear straight path 

underneath the bridge.  A turn or bend region, shown in Figure 3-2, would be a 

place where the bridge crosses the channel while the channel is changing 

directions (See Figure 3-1 for an illustration of a turn region and Figure 3-2 for a 

channel bend region.).  The transition region is a 3000-foot long region before and 

after the turn or bend region.  If a bridge is located in a transition region, it is 

more difficult for a vessel to navigate the channel than with a straight channel, but 

not quite as challenging as it would be in a turn or bend region.  The difference 

between a turn region and a bend region is only that a turn region has a sharp-

angled change in channel geometry while a bend region has a smoother curved-

angle change.  However, both turn and bend regions are handled the same way in 

the AASHTO LRFD code. 

  
For straight regions: 

 0.1=BR  (3.5) 

For transition regions: 
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For turn/bend regions: 
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where: 

RB  =  Correction factor for bridge location, 

θ  =  Angle of turn or bend (°) as shown in Figure 3-1 and Figure 

3-2. 
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3.1.2.3 Correction for Current 

In the computation of the probability of aberrancy, these are the next two 

corrections that account for the velocity of the water current.  It is necessary to 

correct for both the current flow parallel to the vessel traffic and the current flow 

perpendicular to the vessel traffic.  As the current velocity increases, it becomes 

more difficult to maintain the vessel’s heading.  Currents in the two directions do 

not have an equal effect on vessel aberrancy.  The correction factor for the cross 

current has ten times the influence of that for parallel currents. 

 

 ⎟
⎠
⎞

⎜
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⎛ +=

10
1 C

C
V

R  (3.8) 

 

where: 

RC  =  Correction factor for current parallel to the direction of vessel 

traffic, 

VC  =  Velocity of current parallel to the direction of vessel traffic 

(knots). 

 

 ( )XCXC VR += 1  (3.9) 

 

where: 

RXC  =  Correction factor for current perpendicular to the direction 

vessel traffic, 

VXC  =  Velocity of current perpendicular to the direction of vessel 

traffic (knots). 
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3.1.2.4 Correction Factor for Vessel Traffic Density 

The final correction factor in the computation of probability of aberrancy 

is due to vessel traffic density in the waterway.  Higher traffic density equates to 

an increased probability that a vessel will become aberrant.  The AASHTO LRFD 

code categorizes traffic density very broadly into low, medium, and high levels. 

 

Low traffic density: 

 0.1=DR  (3.10) 

Average traffic density: 

 3.1=DR  (3.11) 

High traffic density: 

 6.1=DR  (3.12) 

 

where: 

RD  =  Correction factor for traffic density. 

 

The combination of the aberrancy base rate and the four correction factors 

described above yields an estimate for the probability of aberrancy.  In general, a 

higher probability of aberrancy can directly lead to a higher annual frequency of 

collapse or a lower return period. 

3.1.2.5 Limitations 

The equations for probability of aberrancy in the AASHTO LRFD code 

were developed in the AASHTO Guide Specifications (AASHTO, 1991).  Data 

from bridges around the world were collected and led to estimates base rates of 

aberrancy for ships and barges.  The base rate for barges was found to be two to 

three times higher than that for ships.  The limitations associated with probability 
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of aberrancy stem mostly from the quality and quantity of available data and the 

lack of ability to make appropriate site-specific modifications.  The four 

correction factors used in the AASHTO LRFD code are just a few of the many 

different variables that determine whether a vessel becomes aberrant.  Other 

variables such as wind, visibility conditions, navigation aids, and human error can 

have a strong influence on the probability of aberrancy but they were not directly 

included in the AASHTO LRFD code as they were considered to difficult to 

quantify.  Such factors were indirectly accounted for in the base rate; however, if 

any one of these is particularly significant at a given waterway and bridge 

location, its influence on the results would not be indicated.  Human error which 

accounts for 60 to 85 percent of all aberrant vessels is the most difficult variable 

to quantify. 

It is expected that advances in technology such as computer-guided 

vessels and warning technologies would be able to vastly improve the base rate 

for vessels.  Technological improvements should also decrease the influence of 

the four correction factors that were accounted for. 

3.1.3 Geometric Probability (PG) 

Once a vessel has become aberrant, it is then necessary to estimate the 

probability that the vessel will strike the bridge.  To do this, geometric 

considerations are necessary.  The geometric probability is based on a number of 

parameters including the geometry of the waterway, water depth, location of 

bridge piers, span clearance, sailing path of vessel, maneuvering characteristics of 

the vessel, location, heading and velocity of vessel, rudder angle at time of failure, 

environmental conditions, width, length, and shape of vessel, and vessel draft.   

The AASHTO LRFD code uses a normal distribution to account for 

geometric probability.  The standard deviation is taken as the overall length of the 
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vessel (LOA).  The probability density function for a normally distributed random 

variable is as follow: 

 

 
2

2
1

2
1)(

⎟
⎠
⎞

⎜
⎝
⎛ −

−

= σ
µ

πσ

x

exf  (3.13) 

 

where: 

σ  =  Standard deviation (For PG, σ = LOA), 

µ = Mean (For PG, µ = 0). 

 
To determine the geometric probability, two points are plotted on the x-

axis.    The variable x refers to the possible location of the center of a vessel 

relative to the centerline of a channel.  This can be viewed in Figure 3-3. 
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Figure 3-3:  Normal distribution curve for geometric probability. (AASHTO 

LRFD code Figure 3.14.5.3-1) 

 

The geometric probability represents the probability that the vessel lies 

between X1 and X2 (See Figure 3-3).   
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where: 

X1 =  Lower bound for location of vessel that can collide with the 

pier, 

X2 =  Upper bound for location of vessel that can collide with the 

pier, 

x =  Distance from centerline of navigable channel to centerline of 

pier, 

BP  =  Width of pier, 

BM  =  Width of vessel, 

LOA  =  Length overall of vessel. 

 

The geometric probability, PG, is the area under the normal distribution 

curve between X2 and X1: 

 

 )()( 12 XXPG Φ−Φ=  (3.16) 

 

where: 

 

PG = Geometric Probability, 

Φ(Xi) = Standard normal cumulative distribution function evaluated at 

xi, 

X1 =  Lower bound probability, 

X2 =  Upper bound probability. 

 

It has been shown in various studies, most notably in the development of 

the AASHTO Guide specification (AASHTO, 1991), that piers outside of 3LOA 

from the navigable channel centerline are unlikely to be struck by a vessel.  
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Therefore, any piers more than 3LOA away from the centerline of the navigable 

channel are not considered in the computation of PG. 

3.1.3.1 Limitations 

The limitations of estimating the geometric probability of geometry are 

due to lack of data on barge collisions.  In developing a model for estimating 

geometric probability, a wide variety of ship data was available, however very 

few data referring to barge collisions exist.  The AASHTO LRFD code 

recommends that the same standard deviation of LOA be used for barge groups, 

even though there is no statistical evidence to support that value. 

3.1.4 Probability of Collapse (PC) 

Given that vessel has gone aberrant and has struck a pier, it is then 

necessary to estimate the probability that the bridge will collapse.  Several 

variables including vessel size, type, configuration, speed, direction of impact, 

and mass influence the probability of collapse.  The stiffness of the bridge pier 

and the nature of bridge superstructure also influence the probability of bridge 

collapse.  

The AASHTO LRFD code Section 3.14.5.4 which addresses probability 

of collapse was developed by Cowiconsult (1987) based of studies performed by 

Fujii and Shiobara (1978) using Japanese historical damage data on vessels 

colliding at sea (AASHTO LRFD C3.14.5.4).  The ratio of ultimate lateral 

resistance to the vessel impact force is computed in order to estimate the 

probability of collapse.  The LRFD equations governing probability of collapse 

are as follow: 
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If 0.0 ≤ H/P < 0.1 : 
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If 0.1 ≤ H/P < 1.0 : 

 

 ⎟
⎠
⎞

⎜
⎝
⎛ −=

P
H1

9
1PC  (3.18) 

 

If H/P ≥ 1.0 : 

 

 0.0=PC  (3.19) 

 

where: 

PC  =  Probability of collapse, 

H  =  Ultimate lateral resistance of pier (kips), 

P = Vessel impact force (kips). 

 

The ultimate strength of a single pier is typically conservatively assumed 

to be the ultimate strength of the entire bridge.  A plot of equations 3.17 to 3.19 

provides a better picture of how the probability of collapse is computed.  As seen 

in Figure 3-4, working from right to left, if the bridge element strength, H, is 

greater than the vessel impact force, P, there is a zero probability that the bridge 

will collapse.  As the H/P ratio increases, the probability of collapse remains low 

until the vessel impact force becomes greater than one-tenth the ultimate lateral 

pier strength.  From then on, small reductions in the H/P ratio cause the 
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probability of collapse increase quite sharply.  Eventually, the probability of 

collapse reaches 1.0 where the vessel impact force exceeds the ultimate lateral 

pier strength. 

 

 

Figure 3-4:  Probability of collapse distribution. (from AASHTO LRFD code 

Figure C3.14.5.4-1) 

3.1.4.1 Ultimate Lateral Pier Strength 

In order to determine the ultimate lateral strength of each pier, a separate 

analysis must be done outside of the AASHTO LRFD code calculation for annual 

frequency of collapse due to vessel impact.  Either a nonlinear static pushover 

analysis or a nonlinear dynamic analysis may be employed for this purpose. 

3.1.4.2 Vessel Impact Force 

The impact force of a vessel on a pier is based on a number of different 

variables including vessel type, vessel impact velocity, strength and stiffness of 

the pier, and the angle of collision.  The kinetic energy of the moving vessel must 
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be computed to determine how much force is transferred from the vessel to the 

pier.  In order to calculate kinetic energy, the impact velocity of the vessel must 

be estimated.   

Vessel velocity is difficult to establish because the velocity of the vessel 

must be combined with the velocity of the current.  In any given waterway, the 

water speed is not constant at all locations across the channel.  In addition, it is 

necessary that the velocity of the vessel be considered when it has become 

aberrant.  Often a vessel that has strayed considerably off course will no longer 

maintain its original speed but will rather be moving with the channel current 

velocity.   

Based on various studies performed in the past, the AASHTO LRFD code 

Section 3.14.6 proposes a means for determination of the vessel velocity.  A linear 

interpolation is used to represent the variation in velocity from the centerline of 

the waterway to the edges of the channel.  Figure 3-5 shows the velocity 

distribution used in the code. 
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Figure 3-5:  Variation of design collision velocity with distance from navigable 

channel centerline. (from AASHTO LRFD code Figure 3.14.6-1) 

 

where: 

V = Design impact velocity, 

VT  =  Typical vessel transit velocity (under normal environmental 

conditions), 

VMIN =  Minimum design impact velocity (not less than the yearly mean 

current velocity), 

x = Distance to face of pier from centerline of channel, 

XC = Distance to edge of channel, 

XL = Distance equal to three times the overall length of the vessel. 

 

Vessel velocity should be determined using typical current velocities and 

taking into account wind and other external forces.  The velocity of a vessel may 

be different for upbound and downbound vessels.  This velocity can be accounted 

for by running two separate calculations, one for each direction.  It would seem 
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logical to add the velocities of the vessel and channel current velocity for 

downbound and subtract them for upbound vessels; however this is not done.  No 

distinction is made regarding vessel motion direction in the AASHTO LRFD 

code.  This is because a minimum velocity, VMIN, is required, as seen in Figure 

3-5, and it must be greater than the yearly mean current velocity.  In other words, 

a negative velocity that might result from a large current opposite to the vessel 

traffic direction is not permitted in the AASHTO LRFD code. 

Once the velocity of the vessel in known, the kinetic energy of the vessel 

can be determined.  Kinetic energy is based on a number of parameters including 

vessel displacement tonnage, impact velocity, and a hydrodynamic mass 

coefficient that accounts for the influence of the surrounding water upon the 

moving vessel.  This is detailed in AASHTO LRFD code Section 3.14.7.  The 

kinetic energy of a moving vessel is computed as follows: 

 

 
2.29

2WVCKE H=  (3.20) 

 

where: 

KE = Vessel collision energy (kip-ft.), 

W  =  Vessel displacement tonnage (tonnes), 

CH =  Hydrodynamic mass coefficient, 

V = Design impact velocity (ft./sec.). 

 
Equation 3.20 is based on the standard ½mV2 formula for kinetic energy 

along with consideration of the hydrodynamic mass coefficient and necessary unit 

conversion factors.  A separate calculation is required for the vessel in loaded and 

unloaded condition.  Vessel displacement tonnage will usually differ based on the 

loading state of the vessel. 
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Using the kinetic energy of the vessel, the impact force transferred from 

the vessel to the pier can be calculated.  A different set of equations is used to 

determine the impact force from ships and barge groups as the geometry and other 

properties of these vessels are significantly different.   

3.1.4.2.1 Vessel Impact Force for Ships 

The impact force of a ship colliding with a pier is based on the ship impact 

velocity and the deadweight tonnage of the ship.  According to the AASHTO 

LRFD code Section 3.14.8 the force is computed as follows: 

 

 DWTVPS 15.8=  (3.21) 

 

where: 

PS = Equivalent static vessel impact force (kips), 

DWT =  Deadweight tonnage of vessel (tonnes), 

V = Design impact velocity (ft./sec.). 

 
 While it is not required for the LRFD calculations for annual 

frequency of bridge collapse, the ship bow damage length can be calculated as 

well.  The bow damage depth is the horizontal length of the ship’s bow that is 

crushed by the impact with the pier.  It is computed based on the impact force 

averaged against the work path.  The AASHTO LRFD code Section 3.14.9 

quantifies ship bow damage depth as follows: 
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 32

where: 

aS = Bow damage length of the ship (ft.), 

KE =  Vessel collision energy (kip-ft.), 

PS = Ship impact force (kip) as determined in Equation 3.21. 

 

The multiplier 1.54 in Equation 3.22 results from the product of three 

other coefficients: a factor of 1.25 accounts for the increase in average impact 

force over time; a factor of 1.11 accounts for the increase in average impact force 

to the 70 percent design fractile; and another factor of 1.11 provides an increase in 

the damage length to provide a similar level of design safety as that used to 

compute the ship collision force. 

3.1.4.2.2 Vessel Impact Force for Barges 

While the bow damage depth is not required for calculating impact forces 

of ships, for a barge it is a key component of the calculation.  Barge impact force 

is directly obtained from the barge bow damage depth.  The AASHTO LRFD 

code Section 3.14.12 expresses barge bow damage depth as follows: 

 

 ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−+= 1

672,5
12.10 KEaB  (3.23) 

 

where: 

aB = Barge bow damage length (ft.), 

KE =  Vessel collision energy (kip-ft.). 
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Based on the barge bow damage length the force imparted by the barge 

group on a pier can be calculated.  The expressions for barge collision force on a 

pier are outlined in the AASHTO LRFD code Section 3.14.11 and are as follow: 

 

If aB < 0.34 : 

 

 BB aP 112,4=  (3.24) 

 

If aB ≥ 0.34 : 

 BB aP 110349,1 +=  (3.25) 

 

where: 

PB = Equivalent static barge impact force (kip), 

aB = Barge bow damage length (ft.). 

 

3.1.4.3 Limitations 

As with geometric probability, the probability of collapse methodology 

outlined above was based on data acquired from ship-to-ship collisions.  Fujii and 

Shiobara (1978) reported on ship-to-ship collisions and Cowiconsult (1987) 

adapted their results to allow the estimation of the probability of collapse caused 

by any vessel including barge groups for which no data were used in the code 

development.  The AASHTO LRFD code acknowledges in the commentary that 

the procedure is proposed only due to a lack of data available on vessel collision 

with bridges. 

In addition to the lack of data on barge collisions, the AASHTO LRFD 

method for calculating probability of collapse does not take into consideration the 
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effects of progressive collapse nor the importance of a given pier in the overall 

bridge collapse.  The AASHTO LRFD code implies that if one pier is considered 

failed, then the entire bridge has failed.  This is a very conservative approach. to.  

It is likely that, in some situations, a pier may be completely removed and the 

bridge could still remain operational and repaired before a collapse occurred.  

Also, losing one pier could cause progressive collapse mechanism.  The 

redundancy is not accounted for in the code calculations.  Consideration for the 

conditional probability of bridge collapse given that a single pie has failed or is 

removed would add accuracy to the calculation of annual frequency of collapse. 

3.2 AASHTO LRFD CODE LIMITATIONS 

While the AASHTO LRFD code guidelines provide a comprehensive 

analysis approach to determining a return period for bridge collapse due to vessel 

impact, there are several limitations in the code.  The AASHTO LRFD code 

attempts to simplify the modeling considerably based on past vessel impact 

studies.  In most cases, the simplification allows the engineer to perform easier 

calculations.  However, in several areas, the code simplification leads to an overly 

conservative approach.  Some sections of the AASHTO LRFD code are based on 

sparse data and limited studies – e.g. computing the probability of bridge collapse 

due to impact from barge groups is based on data on ship-to-ship collision studies.   

3.2.1 Data Limitations 

One of the most significant weaknesses of the AASHTO LRFD code 

guidelines for vessel collision is the heavy reliance on actual data.  While the 

AASHTO LRFD code equations can sometimes offer a reasonable estimate, the 

ability to obtain an estimate of annual frequency of bridge collapse dud to vessel 

impact relies on the availability of a plethora of actual data about the bridge, the 

channel, and the vessel traffic.  It can be either very difficult to accumulate the 
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necessary data and some data will change frequently.  For instance, the depth of 

the water in a channel constantly changes as the channel fills with deposits and is 

dredged on a regular basis.  It is difficult to know what the depth of the channel is 

at any give time.  Other factors likely to change include vessel traffic, types of 

vessels, and channel currents. 

3.3 CONCLUSION 

The AASHTO LRFD design code attempts to provide a framework for the 

probability-based analysis of vessel impact on bridges.  This framework is 

employed in example studies that follow and in the development of a standalone 

analysis program that will be discussed.  
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CHAPTER 4 
Modifications to the AASHTO LRFD Approach 

 

4.1 AREAS OF MODIFICATION 

While the AASHTO LRFD method for the design of bridges for vessel 

collision can often provide reasonable answers, some of its limitations can be 

addressed.  One such area relates to improving the calculation of probability of 

collapse.  Very little research has been performed in the past on barge-to-pier 

collisions; therefore, the code bases calculations for probability of collapse 

entirely on ship-to-ship collision studies.  To address this limitation, some 

preliminary work based on analysis (not testing) is proposed in order to yield 

different probability of collapse curves that might be of interest especially for 

barge impact on bridges. 

4.2 MODIFICATION PROCEDURE 

To develop a probability of collapse curve to be used as an alternative to 

Figure 3-4, it is necessary to carry out a series of analyses that will assess the 

likelihood that the bridge will collapse under different barge collision scenarios.  

The test runs are selected based upon a random sampling of important input 

variables for the analyses which yield impact forces and ultimate bridge strengths. 

4.2.1 Test Variables 

The input variables that will be modified include material properties, angle 

of impact, height or elevation of impact, and vessel loading.  Separate analyses 

that yield vessel impact forces and ultimate strength for each sampled set of 

impact variables need to be carried out. 
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4.2.1.1 Variability of Material Properties 

The material properties of the concrete and the steel reinforcement used in 

most bridge piers can vary considerably.  In order to account for this, a normal 

distribution for concrete compressive strength is used.  According to ACI (ACI, 

2002) Table 5.3.2.2, the mean concrete compressive strength must exceed the 

specified concrete strength by 1,200 psi.  Therefore the mean for 4,000 psi 

concrete would be 5,200 psi.   The coefficient of variation for concrete 

compressive strength is taken as 10%.  Thus we have: 

 

 µ=σ 10.  (4.1) 

 

Where σ and µ are the standard deviation and the mean, respectively of concrete 

compressive strength. 

To insure that a range of concrete compressive strengths are sampled, 

random numbers are generated from ten bins evenly distributed based on the 

cumulative distribution function of a normal random variable.  Compressive 

strength values are thus obtained randomly in this statistical sampling procedure.  

The modulus of elasticity can be determined based on a function relationship with 

the compressive strength of the concrete.  Table 4-1 presents the set of concrete 

compressive strength and modulus of elasticity values obtained for the test 

analyses. 
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Table 4-1: Sampled Material Properties for Concrete. 

Step f'c E
(ksi) (ksi)

1 4.19 3689.6
2 4.65 3888.5
3 4.79 3943.8
4 4.94 4005.5
5 5.08 4063.0
6 5.28 4140.1
7 5.35 4167.6
8 5.59 4263.5
9 5.76 4324.4
10 5.91 4381.9  

4.2.1.2 Variability of the Angle of Impact 

As a given barge group approaches a bridge and becomes aberrant, the 

angle at which it strikes a given bent or pier can vary.  While it is possible to 

strike the bent at any angle between zero and 90 degrees, realistic angles of 

impact are likely to be far more limited.  In order to have a manageable number of 

analyses to perform, the angle of impact for this study is limited to a maximum of 

15 degrees in each direction from a head-on collision.  A zero degree angle is 

considered a head-on collision and the range of impact angles is 30 degrees split 

into five steps of 7.5 degrees each.  Since in most situations, positive and negative 

angles will yield the same results only three values, 15, 7.5 and 0 degrees are 

needed here.  See Table 4-2. 
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Table 4-2: Angles of Impact Considered in the Analyses. 

Step Angle
(deg)

1 15.0
2 7.5
3 0.0
4 -7.5
5 -15.0  

4.2.1.3 Variability of Height/ Elevation of Impact 

Since the water level in the channel changes at all times, the height or 

elevation along a pile where a barge group or vessel may strike is variable.  The 

probability of collapse is expected to vary depending on the height of impact as 

the ultimate strength of the pier is different depending on the location where the 

load is applied.  The load will be applied at two different locations, the normal 

water line and the high water line (See Table 4-3).  In many cases, these two 

locations will be fairly close and hence additional impact locations are not 

considered. 

Table 4-3: Impact Heights used in the Analyses. 

Step Location

1 HWL
2 NWL  

4.2.1.4 Variability of Vessel Loading 

At the time of the impact, a vessel may be fully loaded, completely 

unloaded, or at any loading condition in between.  Analyses will be carried out 

only for the two extreme cases – loaded fully and unloaded (See Table 4-4). 
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Table 4-4: Vessel Loadings used in the Analyses. 

Step Loading

1 Loaded
2 Unloaded  

4.2.1.5 Variable Limitations 

While material properties, angle of impact, impact height, and vessel 

loading are being varied in the analyses, these are not the only variables that could 

be changed.  Superstructure stiffness, boundary conditions, vessel velocity, vessel 

type, pier geometry, and degradation of materials properties could also have been 

modified.  However, a limit of the number of variables is considered in order to 

have a manageable number of analyses to perform.  While some variables (such 

as superstructure stiffness, boundary conditions, degradation of material 

properties) are easier to change and reflect modeling uncertainty, consideration 

for other variables such as vessel type, speed, and pier geometry would require 

extremely large number of analyses.  Again, in the interest of having a 

manageable number of analyses to perform that focus on some of the key sources 

of variability, only the previously described analysis sets are proposed. 

4.2.2 A Proposal for Improved Probability of Collapse Calculations 

Considering all combinations of input parameters that are variable (Table 

4-1 to Table 4-4), a total of 200 different analyses need to be performed.  In each 

analysis, the ultimate lateral strength (H) of a pier and the impact force (P) 

transmitted by the vessel (barge) to the pier are determined.  If P is found to be 

greater than H, a failure is deemed to have occurred.  The fraction of analyses out 

of the 200 proposed that lead to failure is an alternative estimate to the probability 

of collapse value suggested by the AASHTO LRFD code.   
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Such estimates for the probability of bridge collapse due to vessel impact 

clearly have limitations in that they are model-based and not data-based.  

Moreover, numerous analyses are necessary for a single scenario in order to 

estimate the probability of collapse.  Nevertheless, in this study, a software 

program for estimation of the annual frequency of bridge collapse due to vessel 

impact is developed to offer the user the option of alternative probability of 

collapse (PC) estimates which can be obtained using the method outlined in this 

chapter.  
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CHAPTER 5 
Example Calculations 

5.1 CALCULATION METHOD 

As shown in Equation 3.2, the total annual frequency of bridge collapse 

due to vessel impacts is equal to the sum of the annual frequencies of collapse for 

each vessel-pier combination.  A detailed example calculation is presented in this 

chapter.  The calculations are performed using the separate program that was 

developed and discussed in Chapter 7.  To facilitate the understanding of all the 

calculations, the data for each vessel-pier combination are first presented.  Bridge 

and traffic data are simulated here in order to illustrate the 2004 AASHTO LRFD 

method.  All of the equations used for these calculations and some background for 

their development can be found in Chapter 3. 

5.2 THE COLORADO RIVER - FM 521 BRIDGE 

5.2.1 Description of Data 

5.2.1.1 Bridge and Channel Diagrams 

Figure 5-1 shows a stick drawing of the Colorado River – FM 521 Bridge.  

The navigable waterway boundary and centerline are shown as are the high water 

line and the normal water line.  Figure 5-2 shows a satellite image of the bridge 

and the surrounding region of interest. 
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Figure 5-1: Colorado River – FM 521 Bridge Geometry. 
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Figure 5-2: Satellite Image of the Colorado River – FM 521 Bridge and the 

Surrounding Region of Interest. 

5.2.1.2 Bridge Data 

The first step in performing the vessel collision analysis is to determine 

basic bridge properties and the importance classification of the bridge.  Table 5-1 

lists the name of the bridge, the TxDOT structure ID for the bridge, the waterway 

the bridge crosses, the mile marker on the waterway that the bridge is situated at, 

the roadway over the bridge, and the importance classification.  Of all of these 

fields, only the importance classification will be needed later.  The importance 

classification is determined in accordance with AASHTO LRFD code Section 

3.14.3. 
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Table 5-1: Bridge Information 

Bridge Name: Colorado River - FM 521
TxDOT Structure ID: 131580084603009
Waterway: Colorado River
Mile Marker: 100
Roadway: FM 521
Importance Classification: Regular  

 

Once the basic information on the bridge is defined, additional 

information about the piers is collected.  Each pier is first labeled for reference.  

In this case the bridge has four piers labeled from left to right (See Figure 5-1).  

For each pier, its distance from the navigable waterway centerline, the depth of 

the channel at the high water line (HWL) at that pier, the radius of the pier at 

where the high water line crosses, and the ultimate lateral strength (H) are 

recorded.  All of this information is summarized in Table 5-2. 

 

Table 5-2: Pier Data 

Pier Distance from CL HWL Channel Depth Diameter at HWL H
(ft) (ft) (ft) (kips)

1 62.5 22.7 4 450
2 62.5 24.7 4 330
3 152.5 18.7 4 200
4 192.5 13.7 2 200  

 

5.2.1.3 Channel Data 

To perform the analysis, it is necessary to record the channel data.  The 

parallel current velocity, perpendicular current velocity, minimum impact speed, 

navigable channel width, channel region type, channel turn angle, the traffic 

density need to be defined.  It is important to be careful with units as the 
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AASHTO LRFD code equations contain empirical parameters that are often unit-

specific.  The channel data are summarized in Table 5-3. 

 

Table 5-3: Channel Data 

Parallel Current Velocity: 2 ft/s
Perpendicular Current Velocity: 1 ft/s
Minimum Impact Speed: 1.689 ft/s
Navigable Channel Width: 100 ft
Channel Region Type: Transition
Channel Turn Angle: 34 deg
Traffic Density: Low  

5.2.1.4 Vessel Traffic Data 

In addition to bridge, pier, and channel data, traffic data are also required 

in the analysis.  Table 5-4 summarizes the information on all the vessels that will 

pass under the bridge.  The class of vessel, the size of vessel, and the specific type 

of vessel are all defined.  Details related to vessel class, size, and type are 

discussed in Chapter 7.  It is important to note how many times each year a given 

vessel passes under the bridge, whether the vessel is loaded or unloaded, and the 

velocity of the vessel. 

 

Table 5-4: Vessel Fleet Description 

Vessel Name Vessel Class Vessel Size Vessel Type # Trips Loaded of Unloaded Velocity
(Trips/Yr) (knots)

V1 Barge Group TXDOT BG 1 N/A 101 Loaded 6
V2 Barge Group TXDOT BG 2 N/A 29 Loaded 6
V3 Barge Group TXDOT BG 3 N/A 15 Loaded 6  

The specific geometry related to each vessel that passes under the bridge is 

detailed in Table 5-5, Table 5-6, and Table 5-7.  The specific configuration of 

each of the barge groups is displayed in Figure 5-3, Figure 5-4, and Figure 5-5. 
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Table 5-5: Barge Group Description 

Name Barge  Group Type LOA Width Draft Displacement
(ft) (ft) (ft) (tonne)

V1 TXDOT BG 1 452.0 35.0 9.0 3628.1
V2 TXDOT BG 2 655.0 35.0 9.0 5442.2
V3 TXDOT BG 3 850.0 35.0 9.0 7165.5  

 

 

Figure 5-3: Vessel 1 – TXDOT BG 1 – Formation 

 

 

Figure 5-4: Vessel 2 – TXDOT BG 2 – Formation 

 

Figure 5-5: Vessel 3 – TXDOT BG 3 – Formation 

 

Table 5-6: Tug Information 

Name Type Horsepower Length Width Draft Displacement
(ft) (ft) (ft) (ton)

V1 - TG TXDOT Tug 1 62.0 20.0 9.0 181.4
V2 - TG TXDOT Tug 2 70.0 27.0 9.0 272.1
V3 - TG TXDOT Tug 2 70.0 27.0 9.0 272.1  
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Table 5-7: Barge Information 

Name Type Size Length Width Draft Displacement
(ft) (ft) (ft) (tonne)

V1 - BG Covered Hopper Jumbo 195.0 35.0 8.7 1723.4
V2 - BG Covered Hopper Jumbo 195.0 35.0 8.7 1723.4
V3 - BG Covered Hopper Jumbo 195.0 35.0 8.7 1723.4  

5.2.2 Calculation of Annual Frequency of Collapse 

Using the data assembled in Section 5.2.1, computations leading to 

estimates of the annual frequency of collapse can now be carried out.  The 

formulations for all the required calculations are detailed in Chapter 3. 

5.2.2.1 Probability of Aberrancy (PA) 

The expression for calculating probability of aberrancy is given in 

Equation 3.4.  Each of the components that are involved in computing the 

probability of aberrancy is shown in Table 5-8.  Probability of aberrancy is 

calculated for every vessel-pier combination. 

 

Table 5-8: Probability of Aberrancy Calculations 

Vessel Pier BR RB RC RXC RD PA
(1/Yrs)

1 1 0.00012 1.378 1.118 1.592 1.0 0.000294
1 2 0.00012 1.378 1.118 1.592 1.0 0.000294
1 3 0.00012 1.378 1.118 1.592 1.0 0.000294
1 4 0.00012 1.378 1.118 1.592 1.0 0.000294
2 1 0.00012 1.378 1.118 1.592 1.0 0.000294
2 2 0.00012 1.378 1.118 1.592 1.0 0.000294
2 3 0.00012 1.378 1.118 1.592 1.0 0.000294
2 4 0.00012 1.378 1.118 1.592 1.0 0.000294
3 1 0.00012 1.378 1.118 1.592 1.0 0.000294
3 2 0.00012 1.378 1.118 1.592 1.0 0.000294
3 3 0.00012 1.378 1.118 1.592 1.0 0.000294
3 4 0.00012 1.378 1.118 1.592 1.0 0.000294  
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The base rate is assigned depending on the type of vessel that is passing 

the pier.  If the vessel is a ship or tug, the base rate is equal to .00006, for a barge 

or barge group this base rate is .00012.  Table 5-9 shows the base rate for each 

vessel-pier combination. 

 

Table 5-9: Base Rate (BR) Selection 

Vessel Pier Vessel BR

1 1 Barge 0.00012
1 2 Barge 0.00012
1 3 Barge 0.00012
1 4 Barge 0.00012
2 1 Barge 0.00012
2 2 Barge 0.00012
2 3 Barge 0.00012
2 4 Barge 0.00012
3 1 Barge 0.00012
3 2 Barge 0.00012
3 3 Barge 0.00012
3 4 Barge 0.00012  

 

The correction factor for bridge location uses Equations 3.5, 3.6, and 3.7 

depending on the region type.  Chapter 3 also explains how one can determine 

what region type the bridge is located in.  Table 5-10 displays the correction 

factor for bridge location for each of the vessel-pier combinations.  The angle θ in 

Table 5-10 is computed for the study region using the satellite image in Figure 

5-2. 
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Table 5-10: Correction Factor for Bridge Location (RB) Calculations 

Vessel Pier Region θ RB

(deg)
1 1 Transition 34 1.378
1 2 Transition 34 1.378
1 3 Transition 34 1.378
1 4 Transition 34 1.378
2 1 Transition 34 1.378
2 2 Transition 34 1.378
2 3 Transition 34 1.378
2 4 Transition 34 1.378
3 1 Transition 34 1.378
3 2 Transition 34 1.378
3 3 Transition 34 1.378
3 4 Transition 34 1.378  

The correction factors for parallel current and perpendicular current are 

given in Equations 3.8 and 3.9, respectively.  It is important to note that these 

formulas involve unit-dependent empirical constants.  The current velocity values 

and resulting correction factors used to determine probability of aberrancy are 

summarized in Table 5-11 and Table 5-12 for each vessel-pier combination.   

 

Table 5-11: Correction Factor for Parallel Current (RC) Calculations 

Vessel Pier VC VC RC

(ft/sec) (knots)
1 1 2.0 1.185 1.118
1 2 2.0 1.185 1.118
1 3 2.0 1.185 1.118
1 4 2.0 1.185 1.118
2 1 2.0 1.185 1.118
2 2 2.0 1.185 1.118
2 3 2.0 1.185 1.118
2 4 2.0 1.185 1.118
3 1 2.0 1.185 1.118
3 2 2.0 1.185 1.118
3 3 2.0 1.185 1.118
3 4 2.0 1.185 1.118  
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Table 5-12: Correction Factor for Perpendicular Current (RXC) Calculations 

Vessel Pier VXC VXC RXC

(ft/sec) (knots)
1 1 1.0 0.592 1.592
1 2 1.0 0.592 1.592
1 3 1.0 0.592 1.592
1 4 1.0 0.592 1.592
2 1 1.0 0.592 1.592
2 2 1.0 0.592 1.592
2 3 1.0 0.592 1.592
2 4 1.0 0.592 1.592
3 1 1.0 0.592 1.592
3 2 1.0 0.592 1.592
3 3 1.0 0.592 1.592
3 4 1.0 0.592 1.592  

 

The final correction factor for determining the probability of aberrancy is 

due to vessel traffic density.  Chapter 3 explains how traffic density is represented 

and the resulting correction factors due to vessel traffic density are summarized in 

Table 5-13. 
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Table 5-13: Correction Factor for Traffic Density (RD) Calculations 

Vessel Pier Traffic Density RD

1 1 Low 1.0
1 2 Low 1.0
1 3 Low 1.0
1 4 Low 1.0
2 1 Low 1.0
2 2 Low 1.0
2 3 Low 1.0
2 4 Low 1.0
3 1 Low 1.0
3 2 Low 1.0
3 3 Low 1.0
3 4 Low 1.0  

5.2.2.2 Geometric Probability (PG) 

To determine geometric probability, the approach presented in Chapter 3 

Section 3.1.3 is employed.  The various parameters involved in the geometric 

probability calculations for each vessel pier combination are summaraized in 

Table 5-14. 

 

Table 5-14: Geometric Probability (PG) Calculations 

Vessel Pier XP BP BV LOA X1 X2 PG
(ft) (ft) (ft) (ft) (1/Yrs)

1 1 62.5 4.0 35.0 452.0 0.095 0.181 0.034084
1 2 62.5 4.0 35.0 452.0 0.095 0.181 0.034084
1 3 152.5 4.0 35.0 452.0 0.294 0.381 0.032509
1 4 192.5 2.0 35.0 452.0 0.385 0.467 0.029819
2 1 62.5 4.0 35.0 655.0 0.066 0.125 0.023642
2 2 62.5 4.0 35.0 655.0 0.066 0.125 0.023642
2 3 152.5 4.0 35.0 655.0 0.203 0.263 0.023115
2 4 192.5 2.0 35.0 655.0 0.266 0.322 0.021581
3 1 62.5 4.0 35.0 850.0 0.051 0.096 0.018253
3 2 62.5 4.0 35.0 850.0 0.051 0.096 0.018253
3 3 152.5 4.0 35.0 850.0 0.156 0.202 0.018011
3 4 192.5 2.0 35.0 850.0 0.205 0.248 0.016925  
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5.2.2.3 Probability of Collapse (PC) 

Probability of collapse is determined by the method described in Section 

3.1.4.  While the ultimate lateral strength (H) is determined outside of the 

AASHTO LRFD calculations, the load due to the vessel impact may be estimated 

using the AASHTO LRFD code procedure.  Table 5-15 shows the values of H 

and P used to estimate the probability of collapse for each of the vessel-pier 

combinations. 

Table 5-15: Probability of Collapse (PC) Calculations 

Vessel Pier H P H/P PC
(kip) (kip) (1/Yrs)

1 1 450 2274.7 0.198 0.089041
1 2 330 2274.7 0.145 0.094896
1 3 200 2192.6 0.091 0.179043
1 4 200 2155.7 0.093 0.165002
2 1 450 2610.0 0.172 0.091862
2 2 330 2610.0 0.126 0.096966
2 3 200 2537.4 0.079 0.290605
2 4 200 2504.5 0.080 0.281296
3 1 450 2889.9 0.156 0.093716
3 2 330 2889.9 0.114 0.098325
3 3 200 2824.1 0.071 0.362635
3 4 200 2794.3 0.072 0.355830  

 

To determine the force, P, Equation 3.25 is used.  The kinetic energy, KE, 

and barge bow damage length, aB, needed to compute P for each vessel-pier 

calculation are given in Table 5-16.  In this example, all of the vessels in this 

calculation are barge groups; hence, the same procedure for computing P is used 

for all vessel=pier combinations.  Chapter 3 describes how the calculation would 

differ if ships were involved. 
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Table 5-16: Vessel Impact Force (P) Calculations 

Vessel Pier KE aB P
(kip ft) (ft) (kip)

1 1 13219.4 8.415 2274.7
1 2 13219.4 8.415 2274.7
1 3 11735.0 7.669 2192.6
1 4 11088.1 7.334 2155.7
2 1 19914.2 11.464 2610.0
2 2 19914.2 11.464 2610.0
2 3 18378.0 10.803 2537.4
2 4 17698.6 10.505 2504.5
3 1 26276.7 14.008 2889.9
3 2 26276.7 14.008 2889.9
3 3 24718.4 13.410 2824.1
3 4 24024.3 13.139 2794.3  

 

Table 5-17 shows how the kinetic energy (KE) is computed for each 

vessel-pier combinations based on Equation 3.20.  The hydrodynamic mass 

coefficient is determined using the method described in the AASHTO LRFD code  

Section 3.14.7. 

 

Table 5-17: Kinetic Energy (KE) Calculations 

Vessel Pier HWL Depth Draft
Underkeel 
Clearence CH W V KE

(ft) (ft) (ft) (tonne) (ft/s) (kip ft)
1 1 22.7 9.0 13.7 1.05 3628.1 10.066 13219.4
1 2 24.7 9.0 15.7 1.05 3628.1 10.066 13219.4
1 3 18.7 9.0 9.7 1.05 3628.1 9.484 11735.0
1 4 13.7 9.0 4.7 1.05 3628.1 9.219 11088.1
2 1 22.7 9.0 13.7 1.05 5442.2 10.088 19914.2
2 2 24.7 9.0 15.7 1.05 5442.2 10.088 19914.2
2 3 18.7 9.0 9.7 1.05 5442.2 9.691 18378.0
2 4 13.7 9.0 4.7 1.05 5442.2 9.510 17698.6
3 1 22.7 9.0 13.7 1.05 7165.5 10.099 26276.7
3 2 24.7 9.0 15.7 1.05 7165.5 10.099 26276.7
3 3 18.7 9.0 9.7 1.05 7165.5 9.795 24718.4
3 4 13.7 9.0 4.7 1.05 7165.5 9.656 24024.3  
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The method for determining vessel velocity (V) needed in computing 

kinetic energy is described in Section 3.1.4.2.  The various parameters needed for 

the calculations are summarized in Table 5-18. 

 

Table 5-18: Velocity (V) Calculations 

Vessel Pier VT VMin XC LOA XL CLX Pier Width FaceX V
(ft/s) (ft/s) (ft) (ft) (ft) (ft) (ft) (ft) (ft/s)

1 1 10.134 1.689 50.0 452.0 1356.0 62.5 4.0 60.5 10.066
1 2 10.134 1.689 50.0 452.0 1356.0 62.5 4.0 60.5 10.066
1 3 10.134 1.689 50.0 452.0 1356.0 152.5 4.0 150.5 9.484
1 4 10.134 1.689 50.0 452.0 1356.0 192.5 2.0 191.5 9.219
2 1 10.134 1.689 50.0 655.0 1965.0 62.5 4.0 60.5 10.088
2 2 10.134 1.689 50.0 655.0 1965.0 62.5 4.0 60.5 10.088
2 3 10.134 1.689 50.0 655.0 1965.0 152.5 4.0 150.5 9.691
2 4 10.134 1.689 50.0 655.0 1965.0 192.5 2.0 191.5 9.510
3 1 10.134 1.689 50.0 850.0 2550.0 62.5 4.0 60.5 10.099
3 2 10.134 1.689 50.0 850.0 2550.0 62.5 4.0 60.5 10.099
3 3 10.134 1.689 50.0 850.0 2550.0 152.5 4.0 150.5 9.795
3 4 10.134 1.689 50.0 850.0 2550.0 192.5 2.0 191.5 9.656  

5.2.2.4 Vessel Frequency (N) 

For each vessel-pier combination, the number of trips per year by each 

vessel is multiplied by a growth factor to account for increased future vessel 

traffic.  This calculation is summarized in Table 5-19. 

 



 56

Table 5-19: Projected Vessel Frequency (N) Calculations 

Vessel Pier Growth Factor # Trips N
(Trips/Yr) (Trips/Yr)

1 1 1.2 101 121.2
1 2 1.2 101 121.2
1 3 1.2 101 121.2
1 4 1.2 101 121.2
2 1 1.2 29 34.8
2 2 1.2 29 34.8
2 3 1.2 29 34.8
2 4 1.2 29 34.8
3 1 1.2 15 18.0
3 2 1.2 15 18.0
3 3 1.2 15 18.0
3 4 1.2 15 18.0  

5.2.2.5 Return Period 

Finally, using Equation 3.1, the annual frequency of bridge collapse is 

computed for each vessel-pier combination.  Then, all of these annual frequencies 

of collapse are summed, and the reciprocal of this frequency yields the return 

period associated with bridge collapse due to vessel impact.  This calculation is 

summarized in Table 5-20. 
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Table 5-20: Return Period Calculations 

Vessel Pier N PA PG PC AFC
(Trips/Yr) (1/Yrs) (1/Yrs) (1/Yrs) (1/Yrs)

1 1 121.2 0.000294 0.034084 0.089041 0.000108
1 2 121.2 0.000294 0.034084 0.094896 0.000115
1 3 121.2 0.000294 0.032509 0.179043 0.000208
1 4 121.2 0.000294 0.029819 0.165002 0.000176
2 1 34.8 0.000294 0.023642 0.091862 0.000022
2 2 34.8 0.000294 0.023642 0.096966 0.000023
2 3 34.8 0.000294 0.023115 0.290605 0.000069
2 4 34.8 0.000294 0.021581 0.281296 0.000062
3 1 18.0 0.000294 0.018253 0.093716 0.000009
3 2 18.0 0.000294 0.018253 0.098325 0.000010
3 3 18.0 0.000294 0.018011 0.362635 0.000035
3 4 18.0 0.000294 0.016925 0.355830 0.000032

0.000869 1 /Yrs
1150.7 YearsReturn Period:

Sum AFC:
 

 100071150 >.  (5.1) 

 

This bridge passes the AASHTO LRFD specifications. 

 

Since this bridge is classified as “Regular” in terms of importance, its 

return period must be larger than 1000 years.  Since this bridge has a return period 

of 1150.7 years, it passes the AASHTO LRFD requirements. 

 

5.3 THE SAN JACINTO RIVER – EASTBOUND IH-10 BRIDGE 

This second bridge example is provided to reiterate the methods used in 

Section 5.2.  Only the tables and figures are provided as the equations and 

methods are identical to those used in the previous example. 



 58

5.3.1 Description of Data 

5.3.1.1 Bridge and Channel Diagrams 

The bridge and channel diagrams are summarized in Figure 5-6 and Figure 

5-7. 

 

 

Figure 5-6: San Jacinto River – IH 10 Bridge Geometry 
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Figure 5-7: Satellite View of the San Jacinto River – IH 10 Bridge 

5.3.1.2 Bridge Data 

Table 5-21: Bridge Information 

Bridge Name: San Jacinto River - Eastbound IH-10
TxDOT Structure ID: 121020050801317
Waterway: San Jacinto River
Mile Marker: 1
Roadway: Eastbound IH-10
Importance Classification: Regular  
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Table 5-22: Pier Data 

Pier Distance from CL HWL Channel Depth Diameter at HWL H
(ft) (ft) (ft) (kips)

1 135.0 30.7 4.75 997
2 135.0 36.7 4.75 997
3 311.0 20.7 3.75 815  

5.3.1.3 Channel Data 

 

Table 5-23: Channel Data 

Parallel Current Velocity: 2.0 ft/s
Perpendicular Current Velocity: 1.0 ft/s
Minimum Impact Speed: 1.689 ft/s
Navigable Channel Width: 220 ft
Channel Region Type: Bend
Channel Turn Angle: 15 deg
Traffic Density: Low  

5.3.1.4 Vessel Traffic Data 

 

Table 5-24: Vessel Fleet Description 

Vessel Name Vessel Class Vessel Size Vessel Type # Trips Loaded of Unloaded Velocity
(Trips/Yr) (knots)

V1 Barge Group TXDOT BG 4 N/A 677 Loaded 6
V2 Barge Group TXDOT BG 4 N/A 677 Unloaded 6  

 

Table 5-25: Barge Group Description 

Name Barge  Group Type LOA Width Draft Displacement
(ft) (ft) (ft) (tonne)

V1 TXDOT BG 4 257.0 35.0 9.0 1542.0
V2 TXDOT BG 4 257.0 35.0 9.0 568.0  
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Figure 5-8: Vessel 1 – TXDOT BG 4 (V1 Loaded) – Formation 

 

Figure 5-9: Vessel 1 – TXDOT BG 4 (V2 Empty)– Formation 

 

Table 5-26: Tug Information 

Name Type Horsepower Length Width Draft Displacement
(ft) (ft) (ft) (ton)

V1 - TG TXDOT Tug 1 62.0 20.0 9.0 200.0
V2 - TG TXDOT Tug 1 62.0 20.0 9.0 200.0  

 

Table 5-27: Barge Information 

Name Type Size Length Width Draft Displacement
(ft) (ft) (ft) (ton)

V1 - BG Covered Hopper Jumbo 195.0 35.0 7.0 1500.0
V2 - BG Covered Hopper Jumbo 195.0 35.0 2.0 425.8  

2 2
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5.3.2 Calculation of Annual Frequency of Collapse 

5.3.2.1 Probability of Aberrancy (PA) 

 

Table 5-28: Probability of Aberrancy Calculations 

Vessel Pier BR RB RC RXC RD PA
(1/Yrs)

1 1 0.00012 1.333 1.118 1.592 1.0 0.000285
1 2 0.00012 1.333 1.118 1.592 1.0 0.000285
1 3 0.00012 1.333 1.118 1.592 1.0 0.000285
2 1 0.00012 1.333 1.118 1.592 1.0 0.000285
2 2 0.00012 1.333 1.118 1.592 1.0 0.000285
2 3 0.00012 1.333 1.118 1.592 1.0 0.000285  

 

Table 5-29: Base Rate (BR) Selection 

Vessel Pier Vessel BR

1 1 Barge 0.00012
1 2 Barge 0.00012
1 3 Barge 0.00012
2 1 Barge 0.00012
2 2 Barge 0.00012
2 3 Barge 0.00012  

Table 5-30: Correction Factor for Bridge Location (RB) Calculations 

Vessel Pier Region θ RB

(deg)
1 1 Bend 15 1.333
1 2 Bend 15 1.333
1 3 Bend 15 1.333
2 1 Bend 15 1.333
2 2 Bend 15 1.333
2 3 Bend 15 1.333  
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Table 5-31: Correction Factor for Parallel Current (RC) Calculations 

Vessel Pier VC VC RC

(ft/sec) (knots)
1 1 2.0 1.185 1.118
1 2 2.0 1.185 1.118
1 3 2.0 1.185 1.118
2 1 2.0 1.185 1.118
2 2 2.0 1.185 1.118
2 3 2.0 1.185 1.118  

 

Table 5-32: Correction Factor for Perpendicular Current (RXC) Calculations 

Vessel Pier VXC VXC RXC

(ft/sec) (knots)
1 1 1.0 0.592 1.592
1 2 1.0 0.592 1.592
1 3 1.0 0.592 1.592
2 1 1.0 0.592 1.592
2 2 1.0 0.592 1.592
2 3 1.0 0.592 1.592  

 

Table 5-33: Correction Factor for Traffic Density (RD) Calculations 

Vessel Pier Traffic Density RD

1 1 Low 1.0
1 2 Low 1.0
1 3 Low 1.0
2 1 Low 1.0
2 2 Low 1.0
2 3 Low 1.0  
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5.3.2.2 Geometric Probability (PG) 

 

Table 5-34: Geometric Probability (PG) Calculations 

Vessel Pier XP BP BV LOA X1 X2 PG
(ft) (ft) (ft) (ft) (1/Yrs)

1 1 135 4.75 35.0 257.0 0.448 0.603 0.053713
1 2 135 4.75 35.0 257.0 0.448 0.603 0.053713
1 3 311 3.75 35.0 257.0 1.135 1.286 0.028937
2 1 135 4.75 35.0 257.0 0.448 0.603 0.053713
2 2 135 4.75 35.0 257.0 0.448 0.603 0.053713
2 3 311 3.75 35.0 257.0 1.135 1.286 0.028937  

5.3.2.3 Probability of Collapse (PC) 

Table 5-35: Probability of Collapse (PC) Calculations 

Vessel Pier H P H/P PC
(kip) (kip) (1/Yrs)

1 1 997 1792.8 0.556 0.049271
1 2 997 1792.8 0.556 0.049271
1 3 815 1629.8 0.500 0.055493
2 1 997 1530.2 0.652 0.038677
2 2 997 1530.2 0.652 0.038677
2 3 815 1459.9 0.558 0.049033  

 

Table 5-36: Vessel Impact Force (P) Calculations 

Vessel Pier KE aB P
(kip ft) (ft) (kip)

1 1 5374.2 4.034 1792.8
1 2 5374.2 4.034 1792.8
1 3 3194.3 2.553 1629.8
2 1 1979.6 1.647 1530.2
2 2 1979.6 1.647 1530.2
2 3 1176.6 1.008 1459.9  
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Table 5-37: Kinetic Energy (KE) Calculations 

Vessel Pier HWL Depth Draft
Underkeel 
Clearence CH W V KE

(ft) (ft) (ft) (tonne) (ft/s) (kip ft)
1 1 30.7 9.0 21.7 1.05 1542.0 9.845 5374.2
1 2 36.7 9.0 27.7 1.05 1542.0 9.845 5374.2
1 3 20.7 9.0 11.7 1.05 1542.0 7.590 3194.3
2 1 30.7 9.0 21.7 1.05 568.0 9.845 1979.6
2 2 36.7 9.0 27.7 1.05 568.0 9.845 1979.6
2 3 20.7 9.0 11.7 1.05 568.0 7.590 1176.6  

 

 

Table 5-38: Velocity (V) Calculations 

Vessel Pier VT VMin XC LOA XL CLX Pier Width FaceX V
(ft/s) (ft/s) (ft) (ft) (ft) (ft) (ft) (ft) (ft/s)

1 1 10.134 1.689 110.0 257.0 771.0 135.0 4.75 132.625 9.845
1 2 10.134 1.689 110.0 257.0 771.0 135.0 4.75 132.625 9.845
1 3 10.134 1.689 110.0 257.0 771.0 311.0 3.75 309.125 7.590
2 1 10.134 1.689 110.0 257.0 771.0 135.0 4.75 132.625 9.845
2 2 10.134 1.689 110.0 257.0 771.0 135.0 4.75 132.625 9.845
2 3 10.134 1.689 110.0 257.0 771.0 311.0 3.75 309.125 7.590  

5.3.2.4 Vessel Frequency (N) 

Table 5-39: Projected Vessel Frequency (N) Calculations 

Vessel Pier Growth Factor # Trips N
(Trips/Yr) (Trips/Yr)

1 1 1.2 677 812.4
1 2 1.2 677 812.4
1 3 1.2 677 812.4
2 1 1.2 677 812.4
2 2 1.2 677 812.4
2 3 1.2 677 812.4  
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5.3.2.5 Return Period 

 

Table 5-40: Return Period Calculations 

Vessel Pier N PA PG PC AFC
(Trips/Yr) (1/Yrs) (1/Yrs) (1/Yrs) (1/Yrs)

1 1 812.4 0.000285 0.053713 0.049271 0.000613
1 2 812.4 0.000285 0.053713 0.049271 0.000613
1 3 812.4 0.000285 0.028937 0.055493 0.000372
2 1 812.4 0.000285 0.053713 0.038677 0.000481
2 2 812.4 0.000285 0.053713 0.038677 0.000481
2 3 812.4 0.000285 0.028937 0.049033 0.000329

0.002888 1 /Yrs
346.3 YearsReturn Period:

Sum AFC:
 

 10003346 <.  (5.2) 

 

This bridge does not pass the AASHTO LRFD specifications. 

 

This bridge has a return period for collapse due to vessel impact that is 

shorter than 1000 years and, hence, fails to meet the AASHTO LRFD 

specification for a “regular” bridge. 

 

5.4 CONCLUSIONS 

The preceding examples illustrate the procedure involved in Method II of 

the AASHTO LRFD code specifications.  This method aims to provide estimates 

of the annual frequency of collapse of a bridge due to vessel impact.  The 

computations summarized here can be included in a computer analysis program 

which was developed for this study and is discussed in Chapter 7.  
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CHAPTER 6 
Typical Bridge Analysis Results and Insights 

6.1 BRIDGE PERFORMANCE AND RECOMMENDATIONS 

This chapter will focus on the results of a complete analysis of three 

distinct bridges.  For each bridge, the return period is provided and a discussion 

detailing important parameters influencing the bridge vulnerability is included.  

Figure 6-1 lists the bridges that will be discussed in this chapter along with the 

results from the analysis using the AASHTO LRFD approach. 

 
Bridge Name Return Period Pass/Fail

(years)
Colorado River - FM 521 1152 Pass

San Jacinto River - EB IH 10 346 Fail
GIWW - PR 22 12019 Pass  

Figure 6-1: Summary of Bridges Analyzed 

6.1.1 Colorado River – FM 521 

The Colorado River – FM 521 Bridge has a return period of 1152 year 

which passes the AASHTO LRFD requirements of a 1000-year return period for a 

bridge with an importance classification of “Regular.”  While this bridge has a 

return period which is acceptable, it is still useful to examine which piers and 

vessels most influence the annual frequency of bridge collapse.  Figure 6-2 shows 

the bridge geometry and Figure 6-3 shows a satellite image of the bridge and the 

surrounding region of interest. 
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Figure 6-2: Colorado River – FM 521 Bridge Geometry. 
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Figure 6-3: Satellite Image of the Colorado River – FM 521 Bridge and the 

Surrounding Region of Interest. 
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Figure 6-4: Contribution towards the annual frequencies of collapse of a 

particular vessel passing a particular of the Colorado River – FM 521Bridge 

(from the VIOB Report) 

 

Figure 6-5: Contribution towards the annual frequencies of collapse of each 

vessel passing all piers of the Colorado River – FM 521Bridge (from the VIOB 

Report) 

 

Figure 6-6: Contribution towards the annual frequencies of collapse of all 

vessels passing a particular pier of the Colorado River – FM 521 Bridge (from 

the VIOB Report) 
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Figure 6-7: Vessel fleet components for the Colorado River – FM 521 Bridge 

(from the VIOB Report) 

 

Figure 6-8: Pier Information for the Colorado River – FM 521 Bridge (from 

the VIOB Report) 

From the results comparison section of the VIOB Report (discussed 

further in Chapter 7) for the Colorado River – FM 521 Bridge several trends may 

be noted.  First, by studying Figure 6-4 and Figure 6-5, it can be seen that Vessel 

1 has a much greater influence on the return period than does Vessels 2 and 3.  

However, Vessel 3 has a much larger displacement than Vessel 1 and both vessels 

move at the same velocity (See Chapter 5).  It can be concluded that the dominant 

variable in the calculations is vessel trip frequency.  Figure 6-7 lists the trip 

frequency of each type of vessel that passes this bridge.  Each year, Vessel 1 

travels past the bridge 101 times while Vessel 3 travels past it only 15 times.  
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Vessel 2 travels past the bridge 29 times per year.  There is almost a direct 

relationship between the vessel frequency and the percentage contribution to the 

total annual frequency of collapse of the bridge. 

Upon studying at Figure 6-6 in can be seen that Piers 3 and 4 have a much 

far greater influence on the return period than Piers 1 and 2.  At first, this seems 

unexpected because Piers 1 and 2 are closer to the centerline of the navigable 

channel than Piers 3 and 4.  Piers closer to the centerline generally have a higher 

geometric probability.  However, upon further inspection, it is clear that the 

controlling factor in this calculation is the probability of collapse, and as seen in 

Figure 6-8, Piers 3 and 4 both have considerably lower ultimate lateral strengths 

(H) than do Piers 1 and 2.  A low H value leads to a high probability of collapse 

and hence, Piers 3 and 4 have a strong influence on the final return period 

associated with collapse of the Colorado River – FM 521 Bridge.  By studying 

Figure 6-4, both factors identified, namely the vulnerability of Piers 3 and 4 and 

the importance of Vessel 1 are seen to dominate the risk to this bridge. 

6.1.2 San Jacinto River – EB IH 10 

The San Jacinto River – EB IH 10 Bridge is not as straightforward as the 

Colorado River – FM 521 Bridge.  The return period for this bridge is only 346 

years, considerably lower than the AASHTO LRFD required 1000 years for a 

“regular” bridge.  By interpreting the results, a feasible solution for increasing the 

return period may be determined.    Figure 6-9 shows the bridge geometry and 

Figure 6-10 shows a satellite image of the bridge and the surrounding region of 

interest. 
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Figure 6-9: San Jacinto River – IH 10 Bridge Geometry 
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Figure 6-10: Satellite View of the San Jacinto River – IH 10 Bridge and the 

Surrounding Region of Interest. 
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Figure 6-11: Contribution towards the annual frequencies of collapse of  a 

particular vessel passing a particular pier of the San Jacinto River – EB IH 10 

Bridge (from the VIOB Report) 

 

 

Figure 6-12: Contribution towards the annual frequencies of collapse of a 

particular vessel passing all piers of the San Jacinto River – EB IH 10 Bridge 

(from the VIOB Report) 
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Figure 6-13: Contribution towards the annual frequencies of collapse of all 

vessels passing a particular pier of the San Jacinto River – EB IH 10 Bridge 

(from the VIOB Report) 

 

 

Figure 6-14: Annual frequency of collapse values for each vessel-pier 

combination for the San Jacinto River – EB IH 10 Bridge (from the VIOB 

Report) 

 

Upon studying Figure 6-11, Figure 6-12, and Figure 6-13, no obvious 

trends can be seen.  Figure 6-11 shows that there is a fairly equal contribution 
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towards the bridge’s risk from each of the vessel-pier combinations.  However, it 

is necessary to increase the return period associated with collapse of this bridge 

since it is considerably lower than the acceptable value of 1000 years.  The most 

obvious way to improve an existing bridge is to place a dolphin in front of the 

piers to mitigate vessel collision effects significantly.  Placing a dolphin in front 

of a pier effectively changes that pier’s probability of collapse to almost zero and 

therefore makes its annual frequency of collapse also zero.  Installation of a 

dolphin is very expensive though and, therefore, minimizing the number of piers 

that need to be protected can save a considerable amount of money.  Figure 6-13 

clearly indicates that Piers 1 and 2 are of greater risk than Pier 3.  Therefore, 

placing dolphins in front of those two piers could solve the problem of the low 

return period.  In this case, the new return period increases to 1,426 years and 

therefore makes this bridge acceptable under the 2004 AASHTO LRFD 

standards.  The completion of this analysis suggests that a dolphin is not needed 

to protect Pier 3. 

6.1.3 GIWW – PR 22 

The GIWW – PR 22 Bridge illustrates a few different issues that are not a 

concern for the first two bridges discussed.  Having a return period of 12,019 

years, the GIWW – PR 22 Bridge clearly passes the AASHTO LRFD requirement 

of 1000 years for a “regular” bridge.  A detailed study of how this bridge achieves 

such a high return period is still useful.  Figure 6-15 shows the bridge geometry 

and Figure 6-16 shows a satellite image of the bridge and the surrounding region 

of interest. 
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Figure 6-15: GIWW – PR 22 Bridge Geometry 
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Figure 6-16: Satellite View of the GIWW – PR 22 Bridge and the Surrounding 

Region of Interest. 
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Figure 6-17: Contribution towards the annual frequencies of collapse of all 

vessels passing a particular pier of the GIWW – PR 22 Bridge (from the VIOB 

Report) 
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Figure 6-18: Annual frequency of collapse values for each vessel-pier 

combination for the GIWW – PR 22 Bridge (from the VIOB Report) 

It can be seen from Figure 6-17 that only Pier 4 contributes to the annual 

frequency of collapse of the bridge.  Also, it can be seen in Figure 6-18 the reason 

for this is that the probability of collapse is zero for all of the other piers.  The 

reason the probability of collapse is zero though is not the same for all piers.  Pier 

3 is at the same distance from the centerline of the navigable channel line as Pier 

4, but it has a probability of collapse of zero while Pier 4 has a non-zero 

probability of collapse.  Because the ultimate lateral strength of Pier 4 is 2210 
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kips and that of Pier 3 is 3900 kips.  Figure 6-19 shows the effect that the high 

pier strength of Pier 3 has on its probability of collapse, causing it to go to zero.  

The slightly lower pier strength of Pier 4, shown in Figure 6-20, causes the 

probability of collapse to have a non-zero (though small) value. 

 

Figure 6-19: Probability of collapse for Vessel 1 Pier 3 for the GIWW – PR 22 

Bridge (from the VIOB Report) 

 

Figure 6-20: Probability of collapse for Vessel 1 Pier 4 for the GIWW – PR 22 

Bridge (from the VIOB Report) 
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While Pier 3’s negligible influence on the bridge risk can be explained by 

its high ultimate lateral pier strength, Piers 1, 2, 5, and 6 cannot be explained 

similarly.  These outer piers all have an ultimate lateral pier strength of 1000 kips, 

not nearly high enough to drive the probability of collapse to zero.  Rather, outer 

piers have a zero probability of collapse because they are all situated in the very 

low water depths in the channel.  None of the vessels passing this bridge has an 

underkeel clearance that would allow them to strike any of the four outer piers. 

It should also be noted that even though the return period is very high, the 

probability of collapse of this bridge is still not insignificant.  If this bridge were 

still in the design stage, it might be beneficial to increase the ultimate lateral 

strength of Pier 4 so that it too has a negligible probability of collapse.  If this 

were done, the bridge would effectively have an almost infinite return period.  

Often, an infinite return period is optimal when future vessel traffic is difficult to 

predict or when trends suggest rapid growth in traffic.  
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CHAPTER 7 
VIOB:  The Next Generation of Analysis for 

Vessel Impact on Bridges 

7.1 VIOB INTRODUCTION 

If one considers computational effort involved in just one annual 

frequency of collapse calculation, for just one type of vessel passing one pier of 

one bridge, there can be upwards of 100 calculations depending on the type of 

vessel.  If one then assumes a modest number of different vessels, say five, and an 

average number of bridge piers, say four, then over 2000 calculations would be 

required for each bridge to determine the total annual frequency of collapse.  Due 

to the large number of calculations needed to determine the return period of a 

bridge, it is necessary to create an automated solution to the problem.   

7.1.1 Past Vessel Impact Analysis Tools 

The Florida Department of Transportation (FDOT) has made available a 

Mathcad spreadsheet which can be used to determine the annual frequency of 

collapse of a bridge on a Florida waterway using the AASHTO LRFD 

specifications.  While FDOT’s spreadsheet can help to perform the desired vessel 

collision analysis, the program has several limitations.  It is not a standalone 

program, the data are Florida-specific, it is difficult to change, it allows only one 

type of analysis, it does not give a comprehensive output, and it does not allow 

the user to create reports summarizing salient details of the analysis. 

Several problems arise because the Florida Mathcad program is not a 

standalone program.  This can be a minor or major inconvenience depending on 

the severity of the version changes.  Backward compatibility issues with different 
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versions of Mathcad arise sometimes.  The spreadsheet is not logically organized 

in many places, and this problem is exacerbated when the user tries to make 

modifications.  The layout of the fields on a page makes it virtually impossible to 

print the spreadsheet without having stray fields sometimes print on a sheet of 

their own.  While the user can spend time trying to create an acceptable format for 

printing, that time may be better spent analyzing the results. 

7.1.2 The Program VIOB and its Features 

VIOB is a completely standalone program that reads data from a standard 

Microsoft Access database and carries out all of the analysis required to evaluate 

bridges against vessel impact according to the AASHTO LRFD code.  It was 

developed as part of this research study that is reported in this thesis.   

The straightforward approach of VIOB and its conveniently designed user 

interface allow the user to easily insert necessary data and perform calculations 

using the data.  Modifying the database is extremely simple as the vessel libraries 

provide quick viewing and retrieval of data.  Most importantly, the enhanced 

graphical capabilities of VIOB make trouble shooting complicated geometric 

problems a mundane task.  Finally, comprehensive reports can be produced and 

the output allows clear understanding and insights into the results as was seen in 

Chapter 6. 

7.2 USER FLOW CHART 

Figure 7-1 shows a flow chart of the steps that a user would take to 

analyze a bridge in VIOB.  This rest of this chapter provides a detailed 

explanation of each of the features of VIOB.  For a step-by-step example see 

Appendix B. 
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Figure 7-1: User Flow Chart for Analysis of a Single Bridge in VIOB 
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7.3 DESCRIPTION OF THE PROGRAM 

Like most analysis programs, VIOB consists of three parts: a 

preprocessing component, a solver component, and a post processing component.  

Each stage of the program performs different functions and involves different 

relative amounts of user work and computer work. 

7.3.1 Preprocessor 

The preprocessor stage of VIOB is where most of the user input occurs.  

The user inputs all of the data that will be used for the calculations and VIOB 

takes all of the information that the user enters and stores it in a database until the 

calculations are run. 

7.3.1.1 Start Menu 

On first opening the program, the user is greeted by the start menu page, 

shown in Figure 7-2.  On this start menu page, the user has the option to analyze 

an existing bridge, create a new bridge, or delete an existing bridge. 
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Figure 7-2: Start Menu screen shot 

7.3.1.1.1 Work With Existing Bridge 

If the objective is to work with an existing bridge, the user must simply 

select the “Existing Bridge” option button and then select the bridge that he/she 

wishes wish to use from the pull-down menu.  In order to begin working with the 

bridge, the user then clicks the “Start VIOB” button. 
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7.3.1.1.2 Create New Bridge 

If the user wants to create a new bridge, he/she selects the “New Bridge” 

option and the clicks the “Start VIOB” button to enter information about the new 

bridge.  The new bridge form, shown in Figure 7-3, will pop up and the user is 

asked to enter information about the bridge he/she wishes to create. The user must 

enter the waterway which the bridge crosses, the roadway that the bridge is part 

of, the TxDOT Structure ID of the bridge, the number of piers that the bridge has, 

and the unit system with which the user wishes to work.   

 

 

Figure 7-3: New Bridge Screen Shot 

If the user does not enter a bridge name, a name will be created from the 

Cross Waterway and the Roadway in the form: Waterway Name – Roadway 

Name.  In some cases such as with the Queen Isabella Causeway Bridge, an actual 

name for the bridge exists so the user has the option to enter that.  The TxDOT 

Structure ID is a unique number given to the bridge by TxDOT and can be 
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entered at this time.  It is not necessary to provide a number that is a given length 

or even a real number, but something must be entered into the field for the user to 

be allowed to continue. 

The most important number entered at this point in the program is the 

number of piers that the bridge has.  The program will allow the user to enter any 

number between 1 and 50.  However, it is important to realize that for each of 

these piers, some additional information will need to be entered subsequently.  It 

is not recommended to include piers that are not in the waterway or are extremely 

far from the centerline of the channel as they will be unnecessary for the 

calculations and will be mostly wasted effort.  Adding extra piers will not make a 

significant difference in the computation time as the program executes a single 

analysis nearly instantaneously.  It is not possible to change the number of piers in 

the bridge at a later stage; therefore, the user should make sure to enter this 

number correctly.  Future versions of this program will likely include a feature 

allowing the user to add or remove piers from the bridge. 

The final information added on the New Bridge form is a selection of the 

unit system that will be used in the computations.  There are seven physical 

quantities for which units are needed; the user can select either the SI or US 

system of units.  The different unit schemes are listed in Table 7-1.  In future 

versions of VIOB, other unit configurations will likely be added.  As with the 

number of piers, the selected unit system may not be changed at a later stage. 
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Table 7-1: Different unit schemes 

Category US SI
Length ft mm
Mass 1 ton Mg
Mass 2 tonne Mg

Velocity 1 knots km / hr
Velocity 2 ft / s m / s

Force kips N
Energy kip - ft J  

7.3.1.1.3 Delete an Existing Bridge 

To delete an existing bridge the user first goes to the pull-down menu and 

selects the desired bridge.  Next the user goes to the File > Delete Bridge... A 

message box, shown in Figure 7-4, asking the user, “Are you sure you want to 

delete the bridge: Example Bridge?” pops up on the screen.  If the user clicks 

“Yes” then the bridge is deleted and the user is returned to the Start Menu page.  

If the user clicks “No” the bridge is not deleted and the user is returned to the 

Start Menu page. 

 

 

Figure 7-4: Delete Bridge pop-up screen shot 

7.3.1.2 Main Page 

Once the user has either selected to use an existing bridge or created a new 

bridge, the start page closes and the main page, shown in Figure 7-5, is presented.  

The main page has many different features on it including: data display, bridge 
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selection, edit features, plot display, run calculations, and database manipulation.  

A stick plot based on user-input geometry shows the bridge.  In this plot, vessel 

traffic under the bridge moves into or out of the page and vehicle traffic on the 

bridge moves from left to right or vise versa. 

 

Figure 7-5: Main Page Screen Shot 

7.3.1.2.1 Data Display 

On the left hand side of the screen, all of the data about the bridge and the 

channel are displayed so that the user can quickly see this information.  By 

selecting the pier pull-down menu, the user can scroll through the various piers. 

When a pier is selected, the plotted pier on the right corresponding to the selected 

pier will be highlighted in red.  Numbers appearing above the plotted piers 
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indicate the index number of the pier and this number will also turn red when that 

pier is selected by the user. 

On the lower left hand corner of the plot, the origin x and origin y 

locations are noted.  The location of the origin is also indicated by the origin icon.  

The location of any point on the plot can be determined quickly by moving the 

mouse over a point.  The coordinates of the point over which the mouse is located 

will be displayed in the lower right hand corner of the plot display. 

7.3.1.2.2 Changing the Origin 

The user can change the origin location by clicking on Plot > Origin 

Location… from the Main Page.  The user has the ability to change both the X 

origin location and Y origin location independently (See Figure 7-6).  The X 

origin location can be selected to be at any of the piers or at the centerline of the 

navigable channel.  The Y origin can be selected as the pier bottom, pier top, 

channel bottom, normal water line or high water line.  All of the Y origin 

locations are associated with Pier 1.  So if “Pier Top” is selected, the Y origin will 

be the top of Pier 1 even if the X origin is located at the centerline of the 

navigable channel or at a different pier.   

 

Figure 7-6: Origin Location Screen Shot 
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The user selects the desired origin from the pull-down menu.  Once the 

user selects a new origin, all of the geometry data are automatically updated with 

reference to the new origin location. 

7.3.1.2.3 Plot Display 

On the plot itself, several features are displayed and can be turned on or 

off.  Displayed features include: channel bottom, navigable channel boundaries, 

navigable channel centerline, piers, bridge deck, traffic direction labels, normal 

water line, and high water line.  All of these features and their labels can be 

toggled on or off by going to Plot > Display Options… That will bring up a 

Display Options window, shown in Figure 7-7, which allows the user to check 

which features and labels they would like displayed.  The origin and axes can also 

be toggled on and off in this window.   

The user has the ability to change the spacing of the grid lines from the 

Display Options menu.  VIOB offers an Auto Spacing option for both the X and 

Y grids.  If the Auto Spacing feature is turned on, VIOB will automatically space 

the grid lines in an aesthetically pleasing an optimal manner. 
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Figure 7-7: Display Options Screen Shot 

7.3.1.2.4 Refreshing the Plot 

It is possible that the bridge plot will sometimes become “smudged” by 

other programs or windows that are moved over the bridge plot.  In some cases, 

the plot may even disappear completely.  If plot smudging occurs, the user can 

refresh the plot in two ways.  The user can click Plot > Refresh Plot, or he/she 

can click the Refresh Plot button in the lower right hand corner of the Main Page 

window.  Both of these actions will restore the plot of the bridge in the Main Page 

window. 

7.3.1.2.5 Switching to a Different Bridge 

While the main page currently shows the bridge that was selected on the 

Start Page, the user may want to switch bridges or start working on a new bridge.  

The user has bridge-switching capabilities under the File menu.  In order to start a 
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new bridge, the user goes to File > New Bridge… from the Main Page.  Choosing 

the “New Bridge” option will close the Main Page window and reopen the start 

page window.  The “Create New Bridge” option button will already be selected 

for the user.  If the user wants to close the current bridge, he/she clicks on File > 

Close Bridge… If the user chooses the “Close Bridge” option, the Main Page is 

closed and the Start Page is opened again with the “Select Existing Bridge” option 

selected.  If the user wants to open a different bridge, he/she goes to File > Open 

Bridge…  Selecting the “Open Bridge” option has the same effect as selecting the 

“Close Bridge” option.  The Main Page is closed and the Start Page is opened 

with the “Select Existing Bridge” option pre-selected.  Finally, the user can exit 

VIOB by clicking File > Exit. 

7.3.1.2.6 Edit Features 

Input data is divided into three categories: bridge information, pier 

information, and channel information.  The user can access all three of these 

features under the Edit tab.  Further information on these features is provided in 

Sections 7.3.1.3, 7.3.1.4, and 7.3.1.8. 

7.3.1.2.7 Run Calculations 

To run calculations the user clicks on Calculations > Run… Further 

information on this feature is provided in Section 7.3.2 

7.3.1.2.8 Database Manipulation 

All the vessel information is stored in a database and that information is 

accessed under the Database tab.  Under the Database tab, the user can edit the 

Vessel Library, Barge Group Library, Vessel Fleet Library, and the Waterway 

Library.  Further information about each of these databases is provided in Section 

7.3.1.6.   
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7.3.1.3 Edit Bridge Information 

To edit bridge information, the user goes to Edit > Bridge Data… from 

the Main Page.  This will bring up the “Edit Bridge” window, shown in Figure 

7-8, and the user can change several bridge-related variables.  The Bridge Name, 

TxDOT Structure ID, Cross Waterway, Roadway, and Importance Classification 

are all input in the Edit Bridge window.   

Bridge name, cross waterway, and roadway should all have been entered 

earlier when the user first created the bridge.  These values will automatically be 

displayed when the user opens the Edit Bridge window.  As stated earlier, the 

TxDOT Structure ID is a unique identification number that each structure is given 

by the Texas Department of Transportation.  This number may be in any format 

the user chooses.  If the user does not know the true TxDOT Structure ID, this 

number a dummy number may be entered instead.  The TxDOT Structure ID is 

not used for any calculations or as a reference in any other part of the program.   

 

Figure 7-8: Edit Bridge Screen Shot 
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Importance classification is defined in the AASHTO LRFD code Section 

3.14.3.  The user may enter this value as either “Critical” or “Regular,” where the 

default value is “Regular.”  The program will later use this importance factor to 

determine whether the bridge passes the AASHTO LRFD code specifications.  

Pressing the “OK” button will close the window and save any changes the user 

made.  If the user presses the “Cancel” button, data changes made will not have 

been saved. 

7.3.1.4 Edit Pier Information 

To edit individual pier data, the user must click on the Edit > Pier Data… 

tab on the Main Page which will open the “Edit Pier” window, shown in Figure 

7-9.  The “Edit Pier” window allows the user to edit pier height, pier bottom 

elevation, channel bottom elevation, cross-sectional properties, x-location, and 

ultimate transverse pier strength. 
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Figure 7-9: Pier Information Screen Shot 

The pier height is the distance from the top of the foundation to the bridge 

deck.  This value is not used for the calculations but is used to accurately draw the 

bridge on the screen.  In future versions of the program, this number may be 

implemented into the calculations so that the height of the bridge deck can be 

checked to avoid deck collisions.  Also, if structural analysis capabilities are 

integrated into future versions of VIOB, the height of the pier may be important.   

Pier bottom elevation is the location of the top of the pier foundation..  

Similar to pier height, this value is not used is any calculations.  It is only needed 

so that a relative top of the bridge can be determined for plotting purposes.  As 

pier bottom elevation is associated with deck height, this value would be 
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important for future versions of VIOB for the same reasons as with the pier height 

value discarded earlier. 

Channel bottom elevation is the location of the channel bottom at the same 

x-location as the pier.  It is necessary to know this value in determining the depth 

of water at the pier.  The user can enter channel bottom elevation and water levels 

and the program will automatically determine what the channel depth is. 

The cross-sectional properties of the pier are entered into the program in 

the “Edit Pier” window.  The cross-sectional properties are used to determine BP, 

the effective width of the pier if the pier is turned at an angle.  This effective 

width, BP, is defined in the AASHTO LRFD code section 3.14.5.3 and is 

indicated in Figure 7-10.  To aid the user in entering cross-section properties, the 

“Edit Pier” form will draw a scaled version of the pier cross-section. 

 

 

Figure 7-10: Definition of Pier Cross-Sectional Properties 

Pier WidthPier Depth 

Pier Angle 

BP 
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There are four cross-sectional properties necessary for determining BP.  

These include the pier shape, width, depth, and angle.  Since it is possible that the 

pier’s cross-sectional dimensions can change along its height, the AASHTO 

LRFD code recommends using the cross-section at the high water line level to 

represent the worst-case scenario.  If the user wants to use a different location, 

that is possible through data manipulation within VIOB.  The program will 

perform the calculations by using the values entered as high water line values.  If 

the user puts in cross-sectional values at the normal water line and enters the 

normal water line elevation as the high water line elevation, the program would 

perform the calculations for these normal water line cross-sectional values. 

The user has the ability to enter either a circular or rectangular cross-

section into VIOB.  For a circular cross-section, the width and depth are equal, 

and VIOB will automatically make the two values the same.  It is also not 

necessary to enter a pier angle for a circular cross section.  For a rectangular 

cross-section, the pier width, pier depth, and pier angle are defined as shown in 

Figure 7-10. 

In the event that the user wants to enter a cross-section that is neither a 

circle nor a rectangle, he/she could independently determine the effective width of 

the pier and enter it as a circular pier with a diameter equal to the effective width 

of their actual polygonal cross-section. 

The x-Location of the pier is the distance in the x direction that the pier is 

from the origin.  The origin is defined by the user on the Main Page, and the user 

needs to make sure that the x-location entered is appropriate.  The program will 

not permit the user to enter an x-location that would place the piers at a location 

that is inconsistent in any manner. 
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Finally, the Ultimate Transverse Pier Strength is entered in the “Edit Pier” 

window.  Defined in AASHTO LRFD code Section 3.14.5.4, the ultimate lateral 

pier strength is determined by the user outside of VIOB, and then entered into the 

program at this time.  Future versions of VIOB may include a structural analysis 

component that would perform the calculation for the ultimate pier strength. 

7.3.1.5 Edit Channel Information 

To edit channel information the user clicks on Edit > Channel Data… 

from the Main Page.  The “Edit Channel” page, shown in Figure 7-11, allows the 

user to edit all information related to the channel such as width, turn angle, region 

type, navigable channel properties, high water line, normal water line, current 

velocities, minimum impact speed, and vessel traffic density. 
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Figure 7-11: Edit Channel Screen Shot 

When a bridge is first created, its cross waterway is selected.  However, 

the user will need to select the waterway in the “Edit Channel” window to link the 

waterway to any given vessel traffic.  In the Waterway pull-down menu will be a 

list of all waterways that are stored in the database.  If the waterway does not 

exist, the user has the option of choosing a “User Defined” waterway, in which 

case information normally stored in the waterway database and automatically 

entered for the user is manually entered instead. 

Once the user chooses a waterway, the Mile Marker pull-down menu will 

automatically load with all the mile markers that are stored in the database for the 

given waterway.  Choosing a mile marker automatically fills in parallel current 
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velocity, perpendicular current velocity, minimum impact speed, and vessel traffic 

density. 

The user can determine the channel turn angle in two ways.  The first is to 

measure the channel turn angle by hand, independent of the program, and enter 

the value into the turn angle box.  The second way is for the user to load a picture 

of the channel into VIOB and use the built-in protractor to determine the turn 

angle.  To load a picture into the VIOB “Edit Channel” window, the user goes to 

Picture > Load Picture… which will bring up a prompt.  The user then selects 

the picture and it will appear beneath a protractor.  The user can then move the 

square handle to adjust the origin of the cross hairs and move the circular handles 

to rotate the two protractor arms.  The turn angle will always indicate the smaller 

angle between the cross hairs.  The turn angle is defined in AASHTO LRFD 

Section 3.14.5.2.3-1.  The turn region, also defined in AASHTO LRFD code 

Section 3.14.5.2.3-1, can be selected as either straight, transition, turn, or bend. 

The navigable waterway is defined as the dredged part of the channel 

where a given vessel can safely pass under the bridge.  The navigable channel 

width and navigable channel centerline need to be entered by the user. 

The high water line and normal water line are both entered by the user and 

required by VIOB; however, only the high water line is used.  The user can enter 

a dummy number in the normal water line box as that number is not used by the 

program for any calculations.  Entering the correct normal water line can be 

useful visually as both waterlines are plotted on the Main Page. 

The parallel current velocity is the velocity of the current parallel to the 

vessel traffic, and the perpendicular current velocity is the velocity of the current 

perpendicular to vessel traffic.  If the user chooses a waterway, both current 

velocities will be automatically entered from the waterway database.  Minimum 

impact speed, also stored in the waterway database, is defined in the AASHTO 
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LRFD code Section 3.14.6 and must not less than the yearly mean current 

velocity for the bridge location. 

Vessel traffic density is the density level of vessels in the waterway in the 

immediate vicinity of the bridge.  If vessels rarely meet or overtake each other the 

density is considered low.  The density is considered average if vessels 

occasionally meet or pass each other. A bridge where vessels routinely meet or 

pass each other would have a density classified as high.  VIOB will automatically 

determine the vessel density correction factor based on AASHTO LRFD code 

Section 3.14.5.2.3-7, 3-8, and 3-9. 

7.3.1.6 Understanding the Vessel Database 

7.3.1.6.1 Database Flow Chart 

 

 

Figure 7-12: Hierarchy of VIOB Database 
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Figure 7-12 shows the hierarchy of the VIOB database.  It is important to 

understand this hierarchy when working with the VIOB database.  The most basic 

items are vessels. A vessel can be a ship, a tug, or a barge.  Each vessel has 

properties such as length, width and draft.  A barge group is a combination of a 

tug and a series of barges.  A barge group can be considered a fourth type of 

vessel.  A vessel fleet is a combination of all vessels that pass under a given 

bridge.  Hence, a vessel fleet is described in terms of a series of vessels that 

comprise it and the frequency and loading of those vessels as they pass the bridge.   

At any given channel location or mile marker, a certain traffic pattern 

occurs.  That traffic pattern is defined by the vessel fleet; hence, each mile marker 

has a specific vessel fleet that passes it.  A waterway is described by a list of all 

mile markers on its channel.  Understanding the terminology that is associated 

with each type of vessel and vessel group is critical to the user creating and 

editing the database. 

7.3.1.6.2 Vessel Library 

The “Vessel Library” is where all of the different barges, tugs, and ships 

are stored.  The user can access the “Vessel Library” by going to Database > 

Vessel Library… from the “Main Page.”  Once the “Vessel Library” window, 

shown in Figure 7-13,  has been opened, the user has the option to add, edit, or 

delete barges, tugs, or ships.  Data can be entered into the vessel library in either 

US or SI units; however, all units are stored in the database in US units.  An 

alternative method for populating the database is presented in Appendix A. 
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Figure 7-13: Vessel Library Screen Shot 

If the user has a bridge opened that is in SI units and enters a new vessel, 

the input will be assumed to be in SI units as well.  VIOB will convert all 

numbers entered by the user for vessels to US units and store them in the 

database.  The numbers will still be displayed to the user in SI units.  This is only 

the case for vessel data; all bridge and channel data stored in the units in which 

they are entered.   

It is necessary to store vessel data in this manner since the data must be 

available for all bridges.  The user may have opened a bridge and selected US or 

SI units, and the vessel data should be presented accordingly.  Storing the data in 

two separate databases is another option but it is inconvenient for a user trying to 

recreate the database outside of VIOB.  It is not necessary to perform the same 

operations fop bridge and channel data because they are unique to a bridge.  Once 

a bridge is created its units cannot be changed; therefore, the data can be stored in 

any units that it entered in and it will never have to be converted. 
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7.3.1.6.2.1 Create or Edit Barge 

Barges are sorted by Barge Type with a subset for Barge Size.  The user 

has the ability to create a new barge type, edit the barge type or delete the barge 

type.  If the user clicks on the “New…” button in the barge type section, a 

window, shown in Figure 7-14, will pop up asking the user what the name of the 

new barge type is. 

 

 

Figure 7-14: New Barge Screen Shot 

The user enters the name of the barge type, and the “Barge Dimensions” 

window, Figure 7-15, will pop up.  All barge types must have at least one barge 

size; therefore, since a new barge type has been created, the user must input the 

first new barge size.  On the “Barge Dimensions” window, the user enters the 

barge size, length, width, empty draft, loaded draft, empty displacement, and 

loaded displacement. 
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Figure 7-15: New Barge Size Screen Shot 

Once the user presses the “Create” button, the new barge type and barge 

size are added to the vessel library.  The user can then add any other barge sizes 

that are associated with the new barge type by clicking the “New…” button in the 

barge size box on the “Vessel Library” window.  If the user wants to change a 

barge size there is an option to edit the data.  If the user chooses to delete a barge 

type, all the associated barge sizes will be deleted as well. 

7.3.1.6.2.2 Create or Edit a Tug 

Creating a tug works in the same way as for a barge as the user has all of 

the same options with a tug that exist for barges.  Tugs are uniquely identified by 

a type and a horsepower.  The horsepower that is entered for the tug is only a 

label, and the actual value does not matter at all.  If the user wants to assign the 

horsepower as 1 or 9000, it will only serve as a way of distinguishing between 

different horsepowers for the same type of tugs.  When the user clicks on the tug 
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type pull-down menu and selects a type of tug, e.g. “Line Haul,” the horsepower 

pull-down menu is automatically filled with all horsepower tugs that exist for the 

tug type “Line Haul.”  The user can create new tug types, edit tug types, and 

delete tug types.  The user can create, edit, and delete tug horsepowers as well.  

Figure 7-16 shows the window used to enter a new tug name. 

 

 

Figure 7-16: New Tug Type Screen Shot 

 

Tug dimensions that need to be entered are length, width, draft, and 

displacement.  Since a tug is never loaded, there is no distinction between loaded 

and empty draft or loaded and empty displacement.  Figure 7-17 shows the 

window used to enter a new tug horsepower. 
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Figure 7-17: New Tug Horsepower Screen Shot 

7.3.1.6.2.3 Create or Edit a Ship 

As with barges and tugs, the user has the ability to create new ships for the 

vessel library.  Ships are sorted by a two-level system: Type and Dead Weight 

Tonnage (DWT).  Each ship type is comprised of a set of ship DWTs.  The user 

can create, edit, and delete both ship types and ship DWTs.  Figure 7-18 shows 

the window used to edit a ship name. 

 

 

Figure 7-18: Edit Ship Type Screen Shot 
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For a ship, the user must enter the length, beam, ballasted draft and 

displacement, and loaded draft and displacement.  For the ballasted draft, the user 

must enter the draft at both the bow and the stern of the ship.  The program uses 

the stern draft as it is larger.  The number the user enters for the bow ballasted 

draft is never used by VIOB.  The dead weight tonnage should also be entered 

accurately as it is used by VIOB in the calculations; DWT is not simply a label as 

horsepower is for a tug.  Figure 7-19 shows the window for entering a new ship 

DWT. 

 

 

Figure 7-19: New Ship DWT Screen Shot 
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7.3.1.6.3 Assemble Barge Group 

Once the user is satisfied with the vessels in the “Vessel Library,” he/she 

can create barge groups.  To work with the “Barge Group Library,” the user clicks 

on Database > Barge Group Library… from the “Main Page.”  This will bring 

up the “Barge Group Library” window, shown in Figure 7-20.  In this window, 

the user can scroll through different barge groups that have been previously 

assembled and see what their dimensions are.  The user can also create new barge 

groups or delete existing barge groups.   

 

 

Figure 7-20: Barge Group Library Screen Shot 

To create a new barge group, the user clicks on the “New…” button on the 

“Barge Group Library” window which will open the “Create Barge Group” 

window.  A barge group is an assembly of a set of barges pulled or pushed by a 
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tug.  The user can name the barge group as he/she pleases, but it must be a unique 

name as no two barge groups can have identical names.  It is necessary for the 

user to specify how many barges long and wide the barge group is.  For both the 

number of barges long and the number wide, the user may enter a number 

between 1 and 10 as long as the total number of barges is less than 24.  As the 

user enters the configuration of barges, VIOB automatically draws a layout of the 

barge group in the “Create Barge Group” window, shown in Figure 7-21.  Seeing 

a layout of the barge group can help the user ensure that the information entered is 

appropriate.   
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Figure 7-21: Create Barge Group Screen Shot 

The user must specify the type and size of barges that are used in the barge 

group as well as the tug type and tug horsepower is being used in the barge group.  

The barge group will have only one type of barge.  Future versions of VIOB may 

have a feature in which the user can create a barge group with different barges 

assembled together.  For this version of VIOB, it was decided that only one barge 

type would be allowed because in practice most barge groups are configured that 

way and the data input is greatly simplified.  As the user picks which tug and 

barge type will be used, the “Create Barge Group” window will update the 
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statistics for the barge group on the screen.  Again, seeing real-time statistics of 

the barge group characteristics can assure the user that the barge group is 

assembled as desired. 

Once the user has the appropriate information entered into the “Create 

Barge Group” window, pressing the “Create Barge Group” button will save the 

barge group to the database.  The “Create Barge Group” window will reset itself 

upon clicking the “Create Barge Group” button, and the user can enter other barge 

groups.  Once the user has created all of the desired barge groups, pressing the 

“Close” button will close the “Create Barge Group” window and the user will be 

brought back to the “Barge Group Library.” 

7.3.1.6.4 Create Vessel Fleet 

With the vessels and barge groups stored in the libraries, the user can now 

create the vessel fleet.  To create a vessel fleet, the user clicks on Database > 

Vessel Fleet Library… from the “Main Page.”  This will open the “Vessel Fleet 

Library” window, shown in Figure 7-22.  The “Vessel Fleet Library” window has 

a pull-down menu with all the vessel fleets that are stored in the database.  If the 

user selects one of these vessel fleets, all of the vessels which make up the vessel 

fleet will be displayed on the “Vessel Fleet Library” window.  The window also 

shows the vessel’s frequency, loading, and velocity.  For the first time, the user is 

introduced to the term “vessel class.”  Vessel class simply refers to the kind of 

vessel that is being displayed: barge, tug, ship, or barge group.  A barge group 

does not have a vessel size; so, if it is displayed, its vessel size will be “N/A.” 
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Figure 7-22: Vessel Fleet Library Screen Shot 

As with all of the other libraries, the user has the ability to work with the 

“Vessel Fleet Library.”  The user can create a new vessel fleet, edit an existing 

vessel fleet, or delete a vessel fleet.  When finished with the “Vessel Fleet 

Library,” clicking the “Close” button returns the user to the “Main Page.” 

If the user clicks on the “New…” button the “Create Vessel Fleet” 

window, shown in Figure 7-23, will appear.  The user must name the new vessel 

fleet with a unique name because no two vessel fleets can have the same name.  

Also to be entered in the “Create New Vessel Fleet” window are the vessels (that 

will be part of the vessel fleet) and information about each vessel.  For each 

vessel, the user must specify its class, type, size, frequency, loading configuration, 

and velocity. 
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Figure 7-23: Create New Vessel Fleet Form 

When the user selects the vessel class from the vessel class pull-down 

menu, the type and size pull-down menus will automatically reload.  If “barge” is 

selected, the user can select a barge type and barge size; if “tug” is selected, the 

user can select tug type and tug horsepower; and if “ship” is selected, the user can 

choose a ship type and ship DWT.  The user can also select “barge group” from 

the vessel class pull-down menu; in this case, the user only needs to select the 

barge group type. 

Once the user has selected the vessel he/she wants to add to the vessel 

fleet, information about that vessel’s traffic pattern needs to be input.  The user 

must specify the number of trips per year that the vessel makes past a given 



 119

location, whether the vessel is loaded or unloaded during those trips, and what 

velocity the vessel has during each passage.  If a vessel is sometimes loaded and 

sometimes unloaded, the user should add the vessel to the vessel fleet twice, once 

with “loaded” selected and once with “unloaded” selected.  Each time the vessel 

is added, the number of trips for each loading and speed configuration is added 

with it. 

To add the vessel to the vessel fleet, the “Add Vessel to Fleet” button is 

clicked.  The vessel information entered by the user will be transferred to the 

viewing window and the input boxes will be reset.  The user can remove a vessel 

from the fleet by clicking the “Remove Vessel from Fleet” button.  When all of 

the vessels the user wants in the vessel fleet have been added, the user clicks the 

“Create Vessel Fleet” button to create the vessel fleet. 

7.3.1.6.5 Create Waterway 

Now that the user has created a vessel fleet, it is necessary to place that 

vessel fleet at a given mile marker on a waterway.  At a given mile marker of a 

waterway, there are specific channel characteristics and traffic patterns.  The user 

has already created the traffic patterns; now it is necessary to assign them to the 

mile marker.  To do this, the user clicks on Database > Waterway Library… 

from the “Main Page.”  The “Waterway Library” window, shown in Figure 7-24, 

will pop up.  The user has the ability to create a waterway and any mile markers 

that are a part of that waterway.  For any waterway and mile marker that is 

selected, information about that location is displayed in the window. 
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Figure 7-24: Waterway Library Screen Shot 

 

To add a new waterway, the user clicks the “New…” button under the 

waterway category on the “Waterway Library” window.  Once the user creates 

the waterway he/she will have the opportunity to add mile markers to it.   

 

7.3.1.6.6 Create Mile Marker 

If the user clicks the new mile marker button on the “Waterway Library” 

window, a window allowing the user to input information about that waterway 

will pop up, as seen Figure 7-25.  The same window (only with data in it) will pop 
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up if the user clicks the Edit Mile Marker button.  When the “Edit Mile Marker” 

window opens, the user must enter several key statistics about the mile marker.   

 

 

Figure 7-25: Edit Mile Marker Screen Shot 

 

The user must link a vessel fleet to the mile marker and enter the parallel 

and perpendicular currents, the traffic density, and the minimum impact speed.  

When the user edits channel data at a later time and links the channel to a specific 

waterway and mile marker all of the data entered for the mile marker is 

automatically entered into the “Edit Channel” window.   

7.3.2 Solver 

The solver part of VIOB is where all of the calculations are performed.  In 

the code, all of the calculation procedures are located in the “RunAnlaysisCalcs” 
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module.  If at any time modifications are made to the AASHTO LRFD code or a 

new calculation is formulated, adjustments to the VIOB solver should be made in 

this module.  Each separate calculation is performed as its own function; so 

functions can be easily swapped in and out to reflect updates to the AASTHO 

LRFD specifications. 

7.3.2.1 Run Analysis 

With all of the data entered into VIOB, the user can now begin the 

calculations.  To run the analyses, the user clicks on Calculations > Run… from 

the “Main page.”  This will bring up the “Analysis Wizard” window where the 

user can enter a few key pieces of information and determine if the bridge is 

acceptable based on its reurn period associated with collapse due to vessel impact. 

In the “Analysis Wizard” window, shown in Figure 7-26, the only piece of 

information the user must enter is his/her name.  All the other pieces of 

information will be selected automatically.  However, the user can change some 

of the selections that VIOB has pre-selected.  The growth factor that the program 

uses for vessel frequency is input here; the default value is 1.2.  The growth factor 

accounts for possible increases in vessel traffic in future years.  Using a value of 

1.2 for the growth factor is conservative, but it is important to use a growth factor 

as vessel traffic is always changing.  If the user wants to use a less conservative 

value, they can change that value at this point.   
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Figure 7-26: Analysis Wizard Screen Shot 

If the user selected a user-defined waterway in the “Edit Channel” 

window, then the vessel fleet that passes the bridge of choice will not be known.  

If that is the case, then the vessel fleet pull-down menu will not be disabled and 

the user will pick the appropriate vessel fleet.  If the user had already selected the 

waterway and mile marker, VIOB automatically chooses the correct vessel fleet. 

Analysis Type only offers two options, “2004 AASHTO LRFD” and 

“2005 University of Texas,” each with its own assumptions.  The “2004 

AASHTO LRFD” analysis is exactly the analysis in the 2004 AASHTO LRFD 

code, and it will yield the same results as the Guide Specifications.  The 2005 

University of Texas method is based on an alternative approach for computing the 

probability of collapse as outlined in Chapter 4.  This is under development.  In 
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the future, additional methods of analysis could be added to the program and 

selected here. 

Once the user has selected all of the options that are desired for the 

calculation, the final step is to click the “Run Analysis…” button on the “Analysis 

Wizard” page.  This will run the VIOB analysis and yield a result almost 

instantaneously.  The return period and Pass/Fail message will be displayed on the 

“Analysis Wizard” window.  Once the analysis has been run, the “View Details” 

button will be enabled and the user will have the option to look at details in the 

VIOB calculations.   

7.3.3 Postprocessor 

The post-processing section of VIOB allows the user to study the results 

graphically and manipulate it in different ways for interpretation.  Having 

advanced post-processing features makes the results easier to review than is 

possible with only numerical summaries.  Indeed, the various output formats 

provide useful insights into factors that influence the frequency of bridge 

collapses.  VIOB has numerous advanced post-processing features that help the 

user make an educated data-supported decision about the best way to increase the 

return period associated with bridge collapses. 

7.3.3.1 View Detailed Results 

When the user clicks the “View Details…” button from the “Analysis 

Wizard” window the “Results Viewer” window, shown in Figure 7-27, appears.  

Results are split up into several categories and the user can review them in several 

different ways.  In the upper left hand corner of the “Results Viewer” window is 

basic information including the bridge name, vessel fleet, waterway, mile marker, 

analysis type, and waterway.  To the right of the basic information is a box that 

including summary results such as the annual frequency of collapse, return period, 
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importance classification, and whether or not the bridge passes the AASHTO 

LRFD code specifications. 

 

 

Figure 7-27: Results Viewer Screen Shot 
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The user may want to see more detailed information about how each 

calculation is performed.  For any vessel impact analysis, a separate calculation is 

performed for every vessel-pier combination.  Therefore, if there are four piers 

and three vessels, twelve separate calculations of annual frequency of collapse are 

performed, and the results are then summed to get the total annual frequency of 

collapse.  The user can select any vessel-pier combination on the “Results 

Viewer” window, and details about that calculation will appear.  The user can also 

select all piers with a given vessel, or all vessels with a given pier, and see how 

much one specific pier or one specific vessel influences the overall frequency of 

bridge collapse.   

Beneath the box where the user selects the vessel and pier that they want 

to review, are the actual values used by VIOB.  It is important that VIOB display 

these numbers so that the user can ensure that the numbers were entered properly 

and that they seem reasonable.  Every single number used in all of the 

calculations can be reviewed if necessary.  The results are split into categories of 

vessel frequency, probability of aberrancy, geometric probability, and probability 

of collapse. 

If the user clicks on a specific pier and a specific vessel, all of the numbers 

used for that specific calculation are displayed.  However, if the user selects all 

vessels for a specific pier or all piers for a specific vessel, some of the variables 

will be displayed as dashes.  This is because in the group modes, only variables 

that are common to all runs for that group can be shown.  For instance, pier height 

will be shown if all vessels for Pier 2 are requested.  The height of Pier 2 does not 

change for any of the calculations in that group.  On the other hand, if the same 

group is requested, vessel length will not be shown, because each of the vessels 

potentially has a different length; therefore, VIOB displays that variable as “-.” 
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The variables are all grouped together by indents.  So variables indented 

under another variable are used for computation of that variable.  This way the 

user can tell which variables are used to get any specific results.  This is also 

helpful when reviewing the calculations/results. 

7.3.3.2 View Calculations 

One very unique feature of VIOB is that it will display every calculation 

that was made in equation form.  This is a useful way to check the results 

numerically and to read them in a standard way as opposed to from an excessively 

long table.  To view the calculations, the user clicks the check box “Show 

Calculations” on the “Results Viewer” window.  This will cause the window to 

reassemble itself and all of the calculations and plots used to determine the annual 

frequency of collapse will be displayed.  Each calculation shows the equation that 

was used and beneath that the equation with actual numbers plugged in. 

Three plots are also visible when the calculations are shown: the first 

shows the normal distribution curve used for calculating geometric probability; 

the second shows the method for determining velocity; and the third shows the 

formulation of the probability of collapse computation.  Each of these plots shows 

actual points corresponding to the analysis completed. 

7.3.3.3 Compare Results 

Finally, the user can compare different vessel-pier combinations with each 

other to see which ones have the influence on the total annual frequency of 

collapse.  To review this analysis, the user clicks on the check box labeled “Show 

Comparison Plot.”  This allows the user to review the results and determine how 

to improve the return period of the bridge when necessary.  The plot shows each 

vessel-pier combination and the percentage contribution to the total annual 
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frequency of collapse that resulted from that vessel-pier combination.  The user 

can also separate the calculations so as to compare each pier and each vessel. 

7.3.3.4 Print Report 

VIOB gives the user the ability to print a report detailing the results.    To 

print a report, the user clicks the “Print Report…” button on the “Results Viewer” 

window.  There are six different sections that VIOB prints out as part of the 

report.  When the Print Report window, shown in Figure 7-28, first appears the 

checkboxes for all six sections are checked, but the user has the ability to remove 

any section from the report.  The six report sections are the cover page, summary 

page, pier and channel information, vessel fleet description, results comparison, 

and detailed calculations.  A sample report from a VIOB analysis is included in 

APPENDIX C of this thesis.  The objective of the VIOB report is to produce a 

comprehensive outline of the analysis which can serve as both an informative 

report and a hard copy of all data used in the analysis.  The VIOB report is 

designed to look elegant as if it were made on a computer but without sacrificing 

the details of a handwritten report. 
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Figure 7-28: Print Report Screen Shot 

The cover page is simply a front page to the report which details the name 

of the bridge, the TxDOT Structure ID, the waterway, the roadway, the engineer 

involved, and the date the report was created. 

The summary page is a quick overview or abstract of what the geometry 

of the bridge looks like, some very basic data about the channel and the vessel 

fleet, and the basic results of the analysis. 

Pier and channel information are also summarized in detail.  All data 

about each pier are displayed in table format similarly, all data about the channel, 

is also displayed. 

A set of tables with all of the vessel information is portrayed in the vessel 

fleet description section of the VIOB Report.  A table with all of the vessel fleet 

components is always presented in this report section.  Separate tables for barge 

groups, ships, tugs, and barges are presented.  If a specific class of vessel is not in 

the vessel fleet, a table is not included in the report for that vessel class.  The tug 
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and barge tables will list all tugs and barges in the vessel fleet as well as all tugs 

and barges involved in any barge groups that are in the vessel fleet. 

The results comparison section of the VIOB Report is a set of three 

figures.  The first figure shows a comparison of every vessel-pier combination 

and how much it influences the results.  The second figure is a comparison of the 

contribution to bridge collapse due to each of the vessels.  A comparison of all of 

the piers is the third figure in the results comparison section. 

The final section of the VIOB Report includes the detailed calculations.  

For every vessel-pier combination, VIOB will produce a detailed listing of all of 

the calculations and expressions used to get each result.  The report looks similar 

to the “Results Viewer” display.  All of the plots that are drawn for the results 

viewer are also drawn in the detailed calculation section.  The first page of the 

detailed calculation section is a summary of all of the annual frequency of 

collapse estimates for every set of vessel-pier combinations.   

The user should be cautious when printing reports as the number or runs 

printed will be very large if there are many vessels and piers.  The detailed 

calculation section prints six pages for every unique vessel-pier combination.  

Therefore, the size of this report can grow rapidly.  If the user selects a specific 

vessel and pier before clicking the “Print Report” button on the “Results Viewer” 

window, only that detailed calculation will be printed.  This can be a better 

approach to printing the report. 

7.4 VIOB CONCLUSION 

7.4.1 Advantages of VIOB 

Performing a vessel impact analysis on a bridge can be very time-

consuming and tedious.  VIOB turns a difficult problem into a very easy 
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manageable problem.  VIOB is a more useful software program for performing 

vessel impact analysis than any previous automated attempts.   

7.4.2 Future Features 

While VIOB has many remarkable features, there is much room for 

enhancements and improvements.  Future features may include integrating 

structural analysis software directly into VIOB, creating a 3D channel profile 

from the database, 3D viewing of the bridge, more accurate probability of 

collapse calculations, improved graphics, and real-time database updating.  As 

this is only the first version of VIOB, certain kinks are bound to be present.  With 

rigorous testing of VIOB, future versions will be much more reliable and will 

likely be even more user-friendly.  
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CHAPTER 8 
Conclusions 

8.1 SUMMARY OF RESEARCH 

The collapse of the Queen Isabella Causeway in 2001 due to a vessel 

collision was an alarming message to the state of Texas that vessel impact on 

bridges is a serious issue and ma need to be a consideration for all bridges 

spanning waterways.  The failure of the Queen Isabella Causeway resulted in the 

stranding of thousands of people on South Padre Island, economic losses, and 

most disturbingly, several fatalities.  The Texas Department of Transportation 

funded a research project at The University of Texas that was aimed at evaluating 

the AASHTO LRFD code specifications for vessel impact on bridges.   

The goals of the present study were to help develop a database on bridges, 

waterways, and vessel traffic for Texas, and to make use of this database in 

computations of the annual frequency of bridge collapses due to vessel impact.  A 

stand-alone computer program, VIOB, was developed to meet the objectives of 

this research.  The program incorporates a database and performs analysis using 

Method II of the AASHTO LRFD code Specifications.  It also introduces the 

possibility of an alternative method for computing the probability of collapse. 

Past research related to vessel impact on bridges is sparse.  Such research 

did not begin in the United States until the Sunshine Skyway Bridge in Tampa 

Bay, Florida collapsed in 1980 when a ship collided with one of the bridge’s main 

piers.  Today, numerous states such as Florida, Louisiana, and Texas to name a 

few are actively involved in efforts for safety of bridges against vessel impacts. 

Currently the 2004 AASHTO LRFD design code is used to evaluate 

bridges against vessel impact.  Bridges are required to meet a specified maximum 
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allowable annual frequency of collapse which is computed using a probabilistic 

analysis.  A “regular” bridge must have a return period associated with collapse 

due to impact of at least 1000 years.  The total annual frequency of collapse of a 

bridge is the sum of the annual frequencies of collapse considering each pier in 

the bridge and each vessel passing it.   

The annual frequency of collapse is evaluated as the product of the 

number of vessels passing a bridge per year, the probability of aberrancy, the 

geometric probability, and the probability of collapse.  Probability of aberrancy is 

the probability that a vessel will stray off its intended course.  If a vessel becomes 

aberrant, the probability that it will strike the bridge is defined as the geometric 

probability.  The probability of collapse is defined as the probability that the 

bridge will collapse given that it is struck by an aberrant vessel.  An assumption is 

usually made that the collapse of the pier in question leads to bridge collapse. 

While the underlying basis for probability of aberrancy and geometric 

probability calculations is well justified, little research has been performed on 

barge-to-pier collisions to support the AASHTO LRFD code method for 

evaluating probability of collapse.  The code has, due to lack of data on barge-pier 

collisions, relied on older ship-ship collision studies, for example.  In the present 

study, an alternative approach based on modeling is proposed in order to obtain 

the probability of collapse.   

The alternative approach that can be implemented into the software 

program requires finite element studies to obtain vessel impact forces and 

nonlinear static pushover analysis to obtain pier ultimate strengths.  Consideration 

for the variability in material properties, vessel loading condition, angle of impact, 

and height of impact is included in the procedure. 

A user-friendly standalone computer program, named VIOB, has been 

developed.  Using a comprehensive database that includes information on 
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waterways, vessels, and traffic, VIOB can perform an entire bridge analysis for 

vessel impacts.   

Given information related to the bridge and pier geometry, the waterway, 

and the vessel traffic at a given mile marker of a waterway, VIOB is able to 

produce an in-depth report detailing the calculations performed.  The VIOB report 

not only provides information about the analysis performed, but also arranges the 

data so that the user can determine which vessels and piers most influence the 

vulnerability of the bridge.  This allows the user to make educated decisions about 

ways to improve bridges that might not meet the AASHTO LRFD acceptance 

criteria. 

8.2 RECOMMENDATIONS FOR FUTURE RESEARCH 

There are many areas where further research can be carried out to attempt 

to improve the AASHTO LRFD vessel collision design procedure.  The approach 

for calculating probability of collapse is an extremely difficult one to support 

because very few actual tests have been performed involving barge-to-pier 

collisions.  While the computer models generated in this study overall research 

can simulate barge-to-pier collisions, it is impossible to know if the results are 

accurate without a real test to use as a reference.  The few tests that have been 

done that involved barge-to-pier collisions are not very useful because the tests 

were performed at very slow velocities and may not simulate actual vessel impact 

scenarios.  Further development of analytical models to determine vessel impact 

loads and ultimate strength of bridges is also necessary and can be validated with 

full-scale test results. 

VIOB is a very robust program but there are still many improvements that 

can be made to it.  Future versions of VIOB should include a more detailed 

library, enhanced features, and a better user interface.  New features could include 
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3D plotting of the bridge, built-in structural analysis capabilities, and a library 

with real-time updating especially on traffic trends. 
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APPENDIX A 
Description of VIOB Database Tables 

A.1 ALTERNATIVE METHOD FOR ASSEMBLING DATABASE 

For most data being input into the program, it is easy to use the VIOB 

database libraries to enter the data and then choose which vessels are to be used.  

However, if one is entering a large amount of data, it can sometimes be easier to 

create the database in Microsoft Access outside of VIOB, and simply have VIOB 

read in the database.  This appendix describes how each of the vessel-related 

tables needs to be created in the VIOB database. 

For each of the tables below, the names used must be entered exactly as 

shown.  If the tables and table headers are not properly formatted and named, 

VIOB will not be able to understand them.  For each table, a description of the 

table, the database table name, the index for the table, and a list of the column 

headers is given.   

To study some examples of how the tables should look one can open the 

existing VIOB database in Microsoft Access and review the format in which the 

tables are assembled.  Besides the seven tables listed below, there will be others in 

the VIOB database.  Those tables are used for various parts of the program; the 

user should be very cautious about modifying those tables.  If the tables are 

incorrectly changed, VIOB will no longer understand them and will not function 

properly. 
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A.1.1 Waterways 

A.1.1.1 Description 

This table is a list of waterway names, the mile markers associated with 

each waterway, and the channel information associated with those mile markers. 

A.1.1.2 Database Table Name 

The database table name is “WaterwayInfo” 

A.1.1.3 Index 

The “WaterwayInfo” table should be indexed by “Name” and then 

“Milemarker” 

A.1.1.4 Column Headers 

Table A-1: Column headers for “WaterwayInfo” database table 

Column Header Units Data Type Description
Name - text The name of the waterway. i.e. Gulf Intercoastals Waterway (GIWW)
Milemarker - number A given mile marker on a waterway
VesselFleet - text The name of the vessel fleet that passes that mile marker
ParCurrent knots number The current velocity parallel to the direction of vessel traffic
PerpCurrent knots number The current velocity perpendicular to the direction of vessel traffic
TrafficDensity - text The traffic density at any given mile marker.  Entered as High, Average, or 

Low.  See AAHSHTO G.S. 4.8.3.2
MinimumImpactSpeed ft / s number See AASHTO LRFD 3.14.6  

A.1.2 Vessel Fleets 

A.1.2.1 Description 

This table contains a list of all vessel fleets, the vessels associated with 

each vessel fleet, and the properties associated with each vessel as they relate to 

the vessel fleet. 
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A.1.2.2 Database Table Name 

The database table name is “VesselFleets” 

A.1.2.3 Index 

The “VesselFleet” table should be indexed by “Name” then “VesselClass” 

then “VesselType” then “VesselSize” and then “LoadorUnload” 

A.1.2.4 Column Headers 

Table A-2: Column headers for “VesselFleet” database table 

Column Header Units Data Type Description
Name - text The name of the vessel fleet
VesselClass - text The Class of vessel.  Four options: Barge, Tug, Ship, Barge Group
VesselType - text The Type of vessel                                                                          If 

VesselClass = Barge Group, use BargeGroupName for VesselType
VesselSize - text The Size of vessel

If VesselClass = Ship, VesselSize = DWT
If VesselClass = Tug, VesselSize = Horsepower
If VesselClass = Barge, VesselSize = Barge Size
If VesselClass = Barge Group, VesselSize = N/A

NumTrips Trips/Yr number The numer of trips a given vessel makes per year past the bridge
LoadorUnload - True/False Whether the vessel is loaded or unloaded.  True if Loaded, False if 

Unloaded
VesselSpeed knots number The velocity of the vessel  

A.1.3 Barge Group Description 

A.1.3.1 Description 

This table describes the tug type and size and the number of barges in the 

barge group. 

A.1.3.2 Database Table Name 

The database table name is “BargeGroupDescrip” 

A.1.3.3 Index 

The “BargeGroupDescrip” table should be indexed by “Name”  
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A.1.3.4 Column Headers 

Table A-3: Column headers for “BargeGroupDescrip” database table 

Column Header Units Data Type Description
Name - text The name of the barge group
TugType - text The type of tug in the barge group
TugSize - text The horsepower of tug in the barge group
Width  barges number The number of barges wide the barge group is.  

In the y or j direction
Length  barges number The number of barges long the barge group is.  

In the x or i direction  

A.1.4 Barge Group Arrangement 

A.1.4.1 Description 

This table describes the type and size of each barge and where it is located 

spatially in the barge group. 

 

 

Figure A-1: Designation of i and j in a barge group 

A.1.4.2 Database Table Name 

The database table name is “BargeGroupArrange” 

i = 2, j = 1 

i = 1, j = 2 

i = 1, j = 1 

i = 2, j = 2 
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A.1.4.3 Index 

The “BargeGroupArrange” table should be indexed by “Name” then by 

“i” and then by “j” 

A.1.4.4 Column Headers 

Table A-4: Column headers for “BargeGroupArrange” database table 

Column Header Units Data Type Description
Name - text The name of the barge group
BargeType - text The type of barge that is in this i,j position
BargeSize - text The size of barge that is in this i,j position
i - number The x position of a barge in a barge group
j - number The y position of a barge in a barge group  

A.1.5 Barges 

A.1.5.1 Description 

This table consists of all of the different types of barges that are in any 

waterway and the dimensions of those barges. 

A.1.5.2 Database Table Name 

The database table name is “Barges” 

A.1.5.3 Index 

The “Barges” table should be indexed by “Type” and then by “Size”  



 141

A.1.5.4 Column Headers 

Table A-5: Column headers for “Barges” database table 

Column Header Units Data Type Description
Type - text The type of barge. e.g. "Covered Hopper"
Size - text The size of the barge. e.g. "Jumbo"
Length ft number See AASHTO G.S. Figure 3.5.1-1
Width ft number See AASHTO G.S. Figure 3.5.1-1
EmptyDraft ft number See AASHTO G.S. Figure 3.5.1-1
LoadedDraft ft number See AASHTO G.S. Figure 3.5.1-1
EmptyDisplacement ton number See AASHTO G.S. Figure 3.5.1-1
LoadedDisplacement ton number See AASHTO G.S. Figure 3.5.1-1  

A.1.6 Tugs 

A.1.6.1 Description 

This table consists of all of the different types of tugs that are in any 

waterway and the dimensions of those tugs. 

A.1.6.2 Database Table Name 

The database table name is “TugBoats” 

A.1.6.3 Index 

The “TugBoats” table should be indexed by “Type” and then by 

“Horsepower”  
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A.1.6.4 Column Headers 

Table A-6: Column headers for “TugBoats” database table 

Column Header Units Data Type Description
Type - text The type of tug. e.g. "Line Haul"

Horsepower - number The horsepower of the tug. e.g. "2000"

Length ft number See AASHTO G.S. 3.5 Table 3.5.1-2

Width ft number See AASHTO G.S. 3.5 Table 3.5.1-2

Draft ft number See AASHTO G.S. 3.5 Table 3.5.1-2

Displacement ton number See AASHTO G.S. 3.5 Table 3.5.1-2  

A.1.7 Ships 

A.1.7.1 Description 

This table consists of all of the different types of ships that are in any 

waterway and the dimensions of those ships. 

A.1.7.2 Database Table Name 

The database table name is “Ships” 

A.1.7.3 Index 

The “Ships” table should be indexed by “Type” and then by “DWT”  
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A.1.7.4 Column Headers 

Table A-7: Column headers for “Ships” database table 

Column Header Units Data Type Description
Type - text The type of ship. e.g. "Bulk Carrier"
DWT tonne number The DWT of the ship e.g. "1000"
Length ft number See AASHTO G.S. Figure 3.5.2-4
Beam ft number See AASHTO G.S. Figure 3.5.2-4
BallDraftB ft number See AASHTO G.S. Figure 3.5.2-4
BallDraftS ft number See AASHTO G.S. Figure 3.5.2-4
LoadedDraft ft number See AASHTO G.S. Figure 3.5.2-4
BallDisplacement tonne number See AASHTO G.S. Figure 3.5.2-4
LoadedDisplacement tonne number See AASHTO G.S. Figure 3.5.2-4  
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APPENDIX B 
Analysis Example using VIOB 

B.1 INTRODUCTION 

A step-by-step example is presented to give the user some instructions for 

entering a new bridge, assigning bridge properties to the new bridge, and 

performing an analysis on the newly entered bridge.  This example will not show 

how to use all of the features of VIOB nor how to enter information into the 

vessel library.  For an extensive look at all of the features of VIOB, refer to 

Chapter 7. 

B.2 EXAMPLE BRIDGE DESCRIPTION 

In order to determine the return period for a bridge collapse due to vessel 

impact using VIOB, some basic information must be known by the user.  The 

bridge data, pier geometry, and channel data must be known.  For this example, 

the information has been summarized in Table B-1, Table B-2, and Table B-3. 

 

Table B-1: Bridge Data 

Bridge Name: Colorado River - FM 521
TxDOT Structure ID: 131580084603009
Waterway: Colorado River
Mile Marker: 100
Roadway: FM 521
Importance Classification: Regular  
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Table B-2: Pier Geometry 

Pier x Distance 1
Pier 

Height
Pier Bottom 
Elevation 2

Channel Bottom 
Elevation 2

Diameter 
at HWL H

(ft) (ft) (ft) (ft) (ft) (kips)
1 0 45 0 6.16 4 450
2 125 45 0.16 4.16 4 330
3 215 35 10.16 10.16 4 200
4 255 33 12.16 15.16 2 200

1 Measured from Pier 1
2 Measured from Bottom of Pier 1  

 

Table B-3: Channel Data 

Parallel Current Velocity: 1.185 knots
Perpendicular Current Velocity: 0.592 knots
Minimum Impact Speed: 1.689 ft/s
HWL Elevation 2 : 28.86 ft
NWL Elevation 2 : 9.16 ft
Navigable Channel Width: 100 ft
Navigable Channel CL 1 : 62.5 ft
Channel Region Type: Transition
Channel Turn Angle: 34 deg
Traffic Density: Low

1 Measured from Pier 1
2 Measured from Bottom of Pier 1  

 

B.3 CREATE NEW BRIDGE 

The first step in creating a new bridge is to select the “New Bridge” option 

from the “Start Menu.”  Once the “New Bridge” option is selected, the user 

should click the “Start VIOB” button to bring up the “New Bridge” window.  See 

Figure B-1. 
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Figure B-1: “New Bridge” option selected from the “Start Menu” 

 

When the “New Bridge” window pops up, the user should then enter the 

bridge information.  The user must enter the cross waterway, the roadway, the 

TxDOT Structure ID, the number of piers, and the unit system that the user 

intends to use.  See Figure B-2. 
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Figure B-2: Bridge information entered into the “New Bridge” window 

Once the user has entered all of the information into the “New Bridge” 

window, the “Create Bridge” button is pressed.  The “New Bridge” window will 

hide itself and the user will be taken to the “Main Page.”  The initial display is a 

standardized bridge showing the number of piers that the user entered.  In this 

case four piers each with a default height of 50 feet and spaced 100 feet from each 

other will be shown.  The default centerline of the navigable channel is the 

midpoint of the center span of the bridge.  See Figure B-3. 
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Figure B-3: The “Main Page” showing the newly created bridge 

 

B.4 EDIT BRIDGE INFORMATION 

With the new bridge created, one can now edit the bridge information.  To 

do this, the user clicks on Edit > Bridge Data… to open the “Edit Bridge” 

window.  In the “Edit Bridge” window, the user needs to select the bridge’s 

importance classification.  The default value is “Regular.”  Once the importance 

classification is selected, the user clicks the “OK” button to return to the “Main 

Page.”  See Figure B-4 and Figure B-5. 
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Figure B-4: Selecting Bridge Data… from the “Edit” menu 

 

 

Figure B-5: “Edit Bridge” window with importance classification entered 
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B.5 EDIT PIER GEOMETRY 

With the bridge data entered properly, the user can now edit the pier 

geometry.  To edit the pier geometry, the user first selects the pier that he/she 

wants to edit in the pier pull-down menu on the “Main Page” and then clicks on 

Edit > Pier Data… which will bring up the “Edit Pier” window.  The user must 

do this for each of the four piers.  See Figure B-6 to Figure B-10.  After the 

information for each pier is entered, the user clicks the “OK” button to return to 

the “Main Page.” 

 

 

Figure B-6: Selecting Pier Data… from the “Edit” menu 
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Figure B-7: Pier 4 being edited in the “Edit Pier” window 

 



 152

 

Figure B-8: “Main Page” after Pier 4 has been edited 

 

Figure B-9: “Main Page” after Pier 3 has been edited 
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Figure B-10: “Main Page” after Pier 2 has been edited 

 

Figure B-11: “Main Page” after Pier 1 has been edited 
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B.6 EDIT CHANNEL DATA 

After the pier geometry has been entered, the next step is to edit the 

channel data.  To do this the user clicks on Edit > Channel Data… to open the 

“Edit Channel” window.  See Figure B-12 and Figure B-13. 

 

 

Figure B-12: Selecting channel data from the “Edit” menu 
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Figure B-13: Default “Edit Channel” window 

When the user opens the “Edit Channel” window for the first time on a 

bridge, the aerial photo of that bridge will not be loaded.  To do this, the user can 

click Picture > Load… which will bring up the file browse window to allow the 

user to select any available bitmap image of the aerial photo for this bridge.  See 

Figure B-14.  Once the aerial photo of the bridge has been loaded, the channel 

window will include the built-in protractor for determining the channel angle.  

The user can now enter all of the channel information.  See Figure B-15. 
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Figure B-14: Selecting the load option from the “Picture” menu 

 

In this example, the waterway and mile marker already exist in the VIOB 

library; therefore, the user can select the waterway and mile marker from the pull-

down menu in the “Edit Channel” window.  Selecting the waterway and the mile 

marker will automatically fill in the current velocities, minimum impact speed, 

and traffic density.  To edit the channel turn angle, the user moves the square 

handle to adjust the protractor’s origin and then moves the circular handles to 

determine the angle of the channel.  If no aerial photo exists, the user can enter the 

angle manually instead.  Once all of the channel data is entered, the user clicks the 

“OK” button to return to the “Main Page.” 
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Figure B-15: “Edit Channel” window with information entered and aerial 

picture loaded 

At this point, all of the necessary information is available and the “Main 

Page” is displayed.  See Figure B-16. 
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Figure B-16: The “Main Page” after the channel data has been edited 

 

B.7 RUN ANALYSIS 

With all of the information about the bridge entered into VIOB, the 

analysis can now be run.  To run an analysis, the user clicks on Calculations > 

Run… on the “Main Page” which will open the “Analysis Wizard.”  See Figure 

B-17 and Figure B-18.  In the “Analysis Wizard” the user must enter his/her name 

only as all of the other information will have been automatically filled out for the 

user.  VIOB knows the vessel fleet because the vessel fleet is assigned to the 

waterway and mile marker assigned to the bridge previously. 
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Figure B-17: Selecting the run option from the “Calculations” menu 

 

 

Figure B-18: “Analysis Wizard” before the analysis is run 
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The user must next click the “Run Analysis…” button on the “Analysis 

Wizard” window.  VIOB will then determine the return period of the bridge and 

summarize the results on the same window.  The user can track the progress of the 

calculations by looking at the calculation progress bar. 

 

 

Figure B-19: “Analysis Wizard” window after “Run Analysis…” has been 

clicked 

Once the analysis has been run, the user can view a detailed set of results 

by clicking on the “View Details” button.  For more information about detailed 

results, refer to Chapter 7.  
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APPENDIX C 
Sample VIOB Report 

C.1 DESCRIPTION 

This appendix contains a sample VIOB Report for a single bridge analysis.  

For this example, all six sections of the report were printed.  To limit the number 

of pages here, the report has been reproduced to show two report pages on every 

one page that follows.  
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